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1.

About this manual

1.1.

Copyrights
The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.
In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.
This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.
The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.
© Copyright 2012 ABB. All rights reserved.

1.2.

Trademarks
ABB is a registered trademark of ABB Group. All other brand or product names mentioned in this document may be trademarks or registered trademarks of their respective
holders.

1.3.

General information
The COM600 Data historian is a relational database designed and optimized for process
information management and extensive history recording. It combines the benefits of
an easy-to-use relational desktop database with industrial reliability, performance, and
real-time functionality to provide an excellent platform for process information management.
Data historian can be used for accurate process performance monitoring by following
process and equipment performance calculations with real-time and history values.
This manual provides thorough information on COM600 Data historian and the use of
the Vtrin user interface.
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1.4.

Document conventions
The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a
window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.
For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the
keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy
a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the File menu.
• The following convention is used for menu operations: MenuName > MenuItem > CascadedMenuItem. For example: select File > New > Type.
• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.
For example, if you enter a value out of range, the following message is displayed:
Entered value
is not valid. The value must be 0 to 30.

•

•

You may be told to enter the string MIF349 in a field. The string is shown as follows
in the procedure:
MIF349
Variables are shown using lowercase letters:
sequence name

1.5.

Use of symbols
This publication includes warning, caution, and information icons that point out safetyrelated conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.
The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.
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The caution icon indicates important information or warning
related to the concept discussed in the text. It might indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

1.6.

Terminology
The following is a list of terms associated with COM600 that you should be familiar
with. The list contains terms that are unique to ABB or have a usage or definition that
is different from standard industry usage.
Term

Description

Alarm

An abnormal state of a condition.

Alarms and Events; AE

An OPC service for providing information about alarms and
events to OPC clients.

Data Access; DA

An OPC service for providing information about process data to
OPC clients.

Data Object; DO

Part of a logical node object representing specific information,
e.g., status or measurement. From an object-oriented point of
view a data object is an instance of a class data object. DOs are
normally used as transaction objects; i.e., they are data structures.

Data Set

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute values.

Device

A physical device that behaves as its own communication node
in the network, e.g. protection relay.

Event

Change of process data or an OPC internal value. Normally, an
event consists of value, quality and timestamp.

Intelligent Electronic Device

A physical IEC 61850 device that behaves as its own communication node in the IEC 61850 protocol.

Logical Device; LD

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.
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Term

Description

Logical Node; LN

The smallest part of a function that exchanges data. A LN is an
object defined by its data and methods.

OPC

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC item

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality and Time Stamp.

Property

Named data item.

Report Control Block

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

SPA device

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

Substation Configuration Lan- XML-based description language for configurations of electrical
guage; SCL
substation IEDs. Defined in IEC 61850 standard.

1.7.

Abbreviations
The following is a list of abbreviations associated with COM600 that you should be
familiar with. See also 1.6, Terminology.

1.8.
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Abbreviation

Description

WebHMI

Web Human Machine Interface

RTDB

Real Time Database. A database designed by ABB Oy for storing process information.

SAB600

Station Automation Builder 600

Related documents
Name of the manual

MRS number

COM600 User’s Manual

1MRS756125

COM600 Operator's Manual

1MRS756705

COM600 HMI Configuration Manual

1MRS756740
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1.9.

Document revisions
Document version/date

Product revision

History

A/13.2.2009

3.3

Document created

B/06.11.2009

3.4

Document revised

C/30.6.2011

3.5

Document revised

D/31.5.2012

4.0

Document revised

E/13.3.2015

4.1

Document revised

F/24.5.2017

5.0

Document revised

G/28.3.2018

5.1

Document revised
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2.

Introduction

2.1.

Overview of COM600
COM600 provides gateway functions for mapping signals between protection and control
IEDs in industrial or utility substations and higher-level systems. It further includes an
optional WebHMI that provides data and information from the substation to the users.
COM600 gathers data from protection and control IEDs and from process devices using
different communication protocols. The supported protocols can be combined freely in
one station computer, limited only by the number of hardware interfaces and the license.
COM600 uses web technology to display data to different users in a professional and
user-friendly manner. The web technology is further used to transfer information to a
network control centre (NCC) or distributed control system (DCS).
COM600 benefits from the potential of the IEC 61850 standard by using the IEC 618506 substation configuration language (SCL) and IEC 61850 -7 communications modeling
regardless of protocol used. As the IEC 61850 data modeling is used for all communication protocols the gateway cross-reference is done in the same way regardless of the
protocol, for example IEC 61850-8-1 or DNP3.
COM600 can be used for efficient substation visualization, monitoring and control with
the optional WebHMI. Measured values from process devices are displayed on the
WebHMI. Single-line diagrams can be used to view any available measured values from
the process devices.
Microsoft Internet Explorer or Google Chrome (with the
ClickOnce extension) is required for displaying data historian
information using the WebHMI.
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3.

Getting started with COM600 Data historian
The COM600 data historian is a relational database designed and optimized for process
information management and extensive history recording.
Vtrin is a user interface client that connects to RTDB database (cpmPlus History database)
in the COM600 computer. History values can be displayed in graphical form, for example
as trends. Vtrin is started from COM600 WebHMI.

HMI_Data_Historian_menu.png

Figure 3-1 Data Historian menu item shown in COM600 WebHMI

3.1.

Logging on/connecting to the database
1.
2.

Click the Data Historian tab in WebHMI.
On the first logon, the Vtrin client is installed.
Click Run in the security warning dialog.
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Security_warning.jpg

Figure 3.1-1 Security warning dialog

The logon window opens:

Vtrin_login.png

Figure 3.1-2 Log On to Database dialog

3.

4.

5.
6.
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In the Location drop-down menu, select the RTDB-COM600 you want to connect
to. The database name consists of the name of the computer or the IP address and
the database in the following format: TCP://computer or IP/RTDB-COM600.
For normal operation, login with the same user name and password as to the COM600
WebHMI. Enter your user name in the User name field and your password in the
Password field.
If you want to use the credentials that you use for logging into Windows, select
Save Current Credentials.
Connect by clicking OK or cancel the connection by clicking Cancel.
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3.2.

Logging off from Vtrin
1.
2.

3.3.

Click
Vtrin's title bar OR select Exit from the Database menu.
When logging off from Vtrin, you are prompted to save the changes in each open
window.

General overview of Vtrin user interface
When logging in, depending on the user rights, available tools are visible in the Tree
view on the left. The tree contains folders, which, in turn, include other folders (subfolders) and windows. The windows display lists, tables, charts, process diagrams, and
reports.
The charts in the tree are displayed in the window area on the right. By default, they
open on top of each other in the size of the full area. The titles of the windows are displayed in tabs at the top of the area.
For a normal Vtrin user, User's Definitions and Variables are shown. User's Definitions
is empty by default at first login and Variables contains the variables that the administrator
has created with SAB600 and added to the database.
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Workspace.png

Figure 3.3-1 Vtrin workspace for a normal Vtrin user

The administrator's Tree view contains Maintenance tools, such as templates for various
trends, and report templates.
Vtrin administrator defines what is shown for normal users, for example, predefined tai
preconfigured trend views.
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WorkspaceAdminView.png

Figure 3.3-2 Vtrin workspace for a Vtrin administrator user

Detailed information about the Vtrin user interface is found later in the following chapters
of this manual.

3.4.

Quick start for creating trend views
To create a new trend view:
1. Right-click User’s Definitions in the tree view and select New Tree Item -> Trend.
New Trend object is created to the tree.
2. Rename the object with a descriptive name.
3. Open the trend view by selecting it in the tree.
When the trend view is opened for the first time, it is empty.
4. To assign variables to the trend view, select Variables from the tree.
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5.

The variable list opens with the variables (such as process measurements), which
have been configured with SAB600 for the Data historian function.
Drag and drop variables from the list to the trend view.
There are several settings to customize the trend view. For example, by default all
variables have individual scaling and limits on the view. If you want variables to
share same scaling and limits, right-click a variable on the bottom of the view and
select Properties from the context menu. In the Properties dialog, select the
Advanced tab and unselect the Individual limits check box.

Vtrin_trend_view1.bmp

Figure 3.4-1 Example trend of COM600

6.

For more information about the settings, see Chapter 5, Charts.
After you are ready with the changes, save them via the Database menu.

An alternative way to create new trend views from the Variables list:
1. Select the variables (hold Ctrl key to select several variables).
2. Right-click the context menu and select Send to trend.
A new trend view is created.
3. From the Database menu, select Save as. Navigate in the Save dialog to the User’s
Definitions object and enter a new name for the trend.
Non-administrator users can only create objects (for example
trend views) below their own User’s Definitions node in the
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tree. Administrator users can create objects to other levels as
well. For example, to create a trend view available for all
users, the administrator user can create it below the root object
in the tree.

In the tree view, the Equipment and Tags node has a structure of the substation with
voltage level and bay objects. To open a trend view containing all variables related to
an object, right-click the object and select Send to -> Trend of all tags.

3.5.

History collection cycles and lengths
By default history values are collected from the variables with following cycles and
history length.
Table 3.5-1 History collection cycles and lengths
CurrentHistory

5 second default sampling
cycle

History stored for 8 days

AVG1minute

1 minute average values

History stored for 8 days

AVG15minute

15 minute average values

History stored for 6 months
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4.

Vtrin workspace
The following table lists the elements in the Vtrin user interface.
Table 4-1 Vtrin user interface elements
Title bar

Window's heading

Menu bar

See 4.1, Menu bar

Tree window

See 4.5, Tree window and 4.7, Tree window and the Properties
dialog

Tab

See 4.9, Window area

Custom toolbar

See 4.3, Custom toolbar

Toolbar

See 4.2, Toolbar

Properties dialog

See 4.6, Properties dialog

Window area

See 4.9, Window area

Status bar

See 4.4, Status bar

Table 4.10-1 lists the most common icons in Vtrin.

4.1.

Menu bar
The menu bar is located under the title bar.

Row_menu_bar.jpg

Figure 4.1-1 Vtrin menu bar

The menu bar includes the following Vtrin menus:
Table 4.1-1 Vtrin menu bar elements

20

Database

See 4.1.1, Database menu

View

See 4.1.2, View menu

Window

See 4.1.3, Window menu

Help

See 4.1.4, Help menu
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4.1.1.

Database menu

Menu_database.jpg

Figure 4.1.1-1 Database menu
Table 4.1.1-1 Database menu items
Item

Description

Connect to...

Opens a connection to another database. Displays a logon window
as described in 3.1, Logging on/connecting to the database.

Save

Saves the active window in the directory tree, if you have changed
the window properties.

Save copy as

Saves the active window in the selected directory in the directory
tree under the selected name.

Page Setup

Sets the page settings for printing. For further information, see
Windows help.

Print Preview

Allows the user to preview the page before printing. For further
information, see Windows help.

Print...

Opens the Print... dialog that allows you to print the content of
the active window to the selected printer. For further information,
see Windows help.

Exit

Closes Vtrin. See also 3.2, Logging off from Vtrin.
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4.1.2.

View menu

View_menu.jpg

Figure 4.1.2-1 View menu
Table 4.1.2-1 View menu items

22

Item

Description

Toolbar

Displays the toolbar by default under the menu bar, see
4.2, Toolbar. Selected by default.

Custom Toolbar

Displays the custom toolbar by default under the Vtrin toolbar,
see 4.3, Custom toolbar. Selected by default. You can change
the order of the toolbars or put them in one row.

Status Bar

Displays the status bar at the bottom of Vtrin, see 4.4, Status
bar. Selected by default.

Tree

Displays the tree in the Tree window, see 4.5, Tree window.
Selected by default.

Properties

Displays the Properties dialog, see 4.6, Properties dialog.
Selected by default.

Data Playback

Not yet supported.

Full Screen

Switches Vtrin to full screen, leaving only the menu bar and
window area (including tabs) in view. To return to the normal
view, click the command again or click Close Full Screen on
the right side of the menu bar.

Save Layout

Saves the workspace layout.

Locked

Locks the appearance of the workspace, meaning that the relative
relationships of the windows can no longer be changed. If you
change the relative relationships after unlocking, the Tree window
and Properties dialog, for example, will remember their new size
the next time they are opened.

Refresh

Refreshes the active window. You can also refresh the active
window by pressing the F5 shortcut key for Refresh.

1MRS756739

COM600 series, Version 5.1
Data Historian Operator's Manual

4.1.3.

Window menu
The commands in the Window menu affect the active window in the window area. See
also 4.9, Window area. Only the commands available for the active window are displayed
in bold.

Menu_window.jpg

Figure 4.1.3-1 Window menu
Table 4.1.3-1 Window menu items
Item

Description

Move to a New Horizontal
Leaf

Moves the active window to a new horizontal leaf.

Move to a New Vertical
Leaf

Moves the active window to a new vertical leaf.

Move to the Next Leaf

Moves the active window to the next leaf.

Move to the Previous Leaf Moves the active window to the previous leaf.

4.1.4.

Help menu

Menu_help.jpg

Figure 4.1.4-1 Help menu
Table 4.1.4-1 Help menu items
Item

Description

Contents...

Not yet supported.

Index...

Not yet supported.

Search...

Not yet supported.

User's Reference Manual

Opens this manual on screen.

About Vtrin

Displays the version of Vtrin. Click Ok to continue.
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about_vtrin.png

Figure 4.1.4-2 About Vtrin dialog

4.2.

Toolbar
By default, the Vtrin toolbar is located below the menu bar.

Row_toolbar.jpg

Figure 4.2-1 Vtrin toolbar
Table 4.2-1 Toolbar elements
Button

Description
Steps backward through the window call path, activating the previous window.

Back
Steps forward through the window call path, activating the following
window.
Forward
Refreshes the active window. You can also refresh the active window by pressing the F5 shortcut key for Refresh.
Refresh
Shows/hides the Tree window.
Tree

See 4.5, Tree window and 4.7, Tree window and the Properties
dialog.
Shows/hides the Properties dialog.

Properties
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Button

Description
Changes the display to design mode.

Designer Mode
Not yet supported.
Data Playback

Print

Opens the Print dialog that allows you to print the content of the
active window to the selected printer. For further information, see
Windows help.
Enlarges Vtrin to full screen, leaving only the menu bar and window

Full Screen

4.3.

area in view. To return to the normal view, click
the right side of the menu bar.

Custom toolbar
The custom toolbar is located below the Vtrin toolbar. You can also move it to the Vtrin
toolbar or change the order of the toolbars.

Row_custom_toolbar.jpg

Figure 4.3-1 Custom toolbar
Table 4.3-1 Custom toolbar elements
Custom toolbar

User-specific: each user can customize a toolbar according to
his or her needs, which are displayed whenever the user connects to the database.
It is a good idea to place frequently used windows as buttons in
this toolbar. The windows can then be easily opened by clicking
the appropriate buttons instead of having to locate the windows
in the tree.

Toolbar

See 4.2, Toolbar.

Adding, editing, and deleting custom toolbar buttons
To add a button to the custom toolbar:
• Drag the window icon from the tree to the custom toolbar. The new button appears
on the right side of the custom toolbar.
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Toolbarbutton_collection_editor.jpg

Figure 4.3-2 Toolbar button collection editor
Table 4.3-1 Toolbar button collection
Members

The buttons that have been defined to belong to the custom toolbar. The buttons are listed from left to right.

ToolBarButton Properties

Properties of the selected button.

Add

Add a new button.

Remove

Delete the selected button.

To delete a button:
1. Open the custom toolbar and right-click to open the menu. In the menu, select the
Edit button.
2. To delete a button, select the button and click Remove.
To edit buttons:
1. Open the custom toolbar and right-click to open the menu. In the menu, select the
Edit button.
2. You can edit the button properties and change the order of buttons:
• To edit the button properties, change the information needed in the ToolbarButton Properties area. Click OK to submit the changes.
• To change the order of the buttons, select the button you want to move and
click
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4.4.

Status bar
The status bar is displayed at the bottom of Vtrin.

Row_status_bar.jpg

Figure 4.4-1 Status bar

It indicates the status of Vtrin (not yet supported) and time. The time on the user’s PC
is indicated by the ( ) icon and the time on the server by the ( ) icon at the right-hand
end of the bar. If the system has an alarm log feature, you can set parameters for process
area-specific indicators for active and unacknowledged alarms on this row. In this case,
the area-specific priority icons indicate the priority of the alarm situation. If the icon is
colored, the log contains active alarms, and if the icon is flashing, the log contains
unacknowledged alarms.

4.5.

Tree window
The Tree window shows the system’s windows (charts) in a hierarchical tree structure.

Tree_window.jpg

Figure 4.5-1 Tree window

The tree contains folders, which, in turn, include other folders (subfolders) and windows.
The windows display lists, tables, charts, process diagrams, and reports.
The procedures for opening and closing the Tree window, as well as moving it within
the workspace, are described in 4.7, Tree window and the Properties dialog.
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Opening folders and windows
To make the tree fully visible:
• If the tree is not fully visible, open it by clicking
by clicking the icon or name of the database.

next to the database icon

or

To open a folder:
• Click next to the folder. You can also click the name of the folder. The symbol
next to an open folder changes to when the folder is opened.
To close an open folder:
• Click . You can also double-click the icon or name of the folder.
•

Open a window by clicking its node icon or name. (The tree can be defined so that
the window can only be opened with a double-click.)

Table 4.10-1 shows some of the most common folder and window icons.

open_window.jpg

Figure 4.5-2 Open window
Table 4.5-1 Open window items
Item

Description

Open

Corresponds to opening a window in the tree. The command is
not available for folders.

Open another

If the view in question is already open, you can open it in another
view by selecting this command.

New Tree Item
Copy
Paste
Delete
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Rename

Opens up the window name field for editing.

Changing the name of the window in the tree changes also the
name visible in the window tab. In case of a trend, the default title
of the trend is also changed. If the trend title is edited separately,
changes in the window name field do not affect the edited title.
Properties...

In some cases, the window is defined in such a way that right-clicking it displays the
following menu. The windows shown in the menu can be opened by clicking them.

Menu_tree_open_right_click.jpg

Figure 4.5-3 Opening menu tree

You can display a tool tip by placing the cursor on a folder or a window. The tool tip
includes additional information on the selected item, if the information has been defined.

4.5.1.

Setting the root of the Tree window
Inside the tree, any folder with content can be set as the root of the tree structure. This
cleans up the tree view for the user. Any unnecessary information, tree folders and nodes,
can be hidden from the user. All folders above or on the same level with the selected
folder are hidden leaving only the contents of the new root folder visible. The new root
folder is set by selecting Set as Root from the pop-up menu of the desired folder.
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Tree_folder_menu_set_as_root.jpg

Figure 4.5.1-1 Setting content as root of the tree window
Menu item

Description

Set as Root

Sets the folder to act as a root of the tree. Only
the contents of the folder are left visible.

The whole tree structure can be retrieved by selecting Reset Root from the popup menu
of newly set root folder.

Tree_folder_menu_reset_root.jpg

Figure 4.5.1-2 Resetting the tree structure
Menu item

Description

Reset Root

Restores the whole tree structure with the original root folder.
The expansion state of the tree is not
restored after the root has been reset
- all folders are collapsed.

4.5.2.

Searching in the Tree window
You can search for items matching your criteria inside the Tree window. The items are
found based on the names of the nodes. The search is started by clicking into the Tree
Search field under the Tree window.
Typing in the first letters narrows down the items visible in the tree.
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Tree_search_tes.jpg

Figure 4.5-1 Searching in the Tree window

Any item names matching the search criteria are left visible in the Tree window, while
others are hidden. Entering a longer or a more descriptive search phrase narrows down
the visible items even more.

Tree_search_test.jpg

Figure 4.5-2 Search results in the Tree window

If no item matches the criteria, the tree is left empty.

Tree_search_empty_tree.jpg

Figure 4.5-3 The Tree window without matching search results

All items in the tree are retrieved by erasing the Tree Search field.
The tree search is case insensitive and uses partial matching criteria. So, for example,
entering a single letter "T" in the search field returns a tree with all the items containing
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"t" or "T" somewhere in the item name. Also, the search phrase "Trend - avg" returns
different results from "avg - Trend". This is because the whole search phrase is searched
for, not a name containing all the words in the search phrase.

4.6.

Properties dialog
The Properties dialog displays the properties of a selected element of certain kinds of
windows in the window area. You can, for example, view the data of a variable selected
from the variable list in a database table. The same information can also be viewed in
the variable list, but the Properties dialog groups the data of a single variable in a vertical
list and also provides an explanation for the data.
For information on how to display the Properties dialog and change its location, see
4.7, Tree window and the Properties dialog.
The way you select an element in a window and display its properties in the Properties
dialog depends on the type of window. For example, to view the properties of a list item
in the Properties dialog, click the item in the first column of the list.

Properties_dialog.jpg

Figure 4.6-1 Properties dialog

Clicking a row in the Properties dialog shows a description of the property in question
at the bottom of the dialog.
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Clicking the buttons at the top of the dialog allows you to select or deselect a data display
option. When an option is selected the button is displayed in white (for example,
).
When an option is deselected, the button is displayed in the same color as the background
(for example,

).

For more detailed information, see 7, Lists.

4.6.1.

Searching in the Properties dialog
The Properties dialog has a similar search tool compared to the Tree.
The search tool is located under the Properties dialog and functions similarly to the
search tool for the Tree window. The property search retrieves properties whose names
(first column on the list) match the search criteria and shows them on the property list.
See 4.5.2, Searching in the Tree window for more details about using the search tool.

4.7.

Tree window and the Properties dialog
The Tree window and the Properties dialog are located on the left side of the workspace.
You can place the windows on top of each other as tabs. The names of the tabs are displayed at the bottom of the area. (The windows shown in the window area have their
own tabs, see 4.9, Window area.) They can also be detached and displayed as individual
windows or minimized into icons. The following sections provide a more detailed
description of the handling of the Tree window and the Properties dialog.

Opening the Tree window and the Properties dialog
•

Select Tree (Properties) from the View menu.

OR
•

Click the toolbar button
(

.

)

Closing the Tree window and the Properties dialog
•

Select Tree (Properties) from the View menu.

OR
•

Click the toolbar button
(

.

)
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OR
•

Click the Close button

in the title bar.

Enlarging and reducing the Tree window and the Properties dialog
•
•

Click in the title bar if you want the window to cover the area of both the Tree
window and the Properties dialog.
Click in the title bar if you want to restore the window to its normal size.

Detaching the Tree window and the Properties dialog
To detach a window:
• Drag it from its title bar or double-click the title bar. You can freely resize a detached
window and move it anywhere you want on the Windows desktop.
To restore the window to its previous fixed location:
• Double-click the title bar.

Reducing the Tree window and the Properties dialog into icons on
the vertical bar
To reduce the window into an icon on the vertical bar:
• Click the title bar button .

Tree_window_as_icon.jpg

Figure 4.7-1 Tree window as icon
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If the window does not open as shown in the following figure, widen the Vtrin on the
screen. To position the window back on the bar, click anywhere outside the window.

To restore the window to its location, click or point to the Tree icon
then click in the title bar.

on the bar and

The button and the title bar are displayed in the active color, if you clicked the icon.
If the window does not open from the bar, first try widening the Vtrin on the screen.

4.8.

Browsing the Tree window history
The Tree window history can be browsed much like the folders in Windows file explorer
or web pages with a web browser. Visited folders and nodes in the tree are accessible
with the Back and Forward browsing buttons. Also the window tabs visited in the
window area are retrievable in the order they were accessed.
The state of the tree is restored to corresponding state when browsing the history. The
state of the tree means, for example, folders that have been expanded or collapsed while
accessing different nodes. When the latest step of the browse history is accessed, the
Forward button is dimmed.

4.9.

Window area
The charts in the tree are displayed in the window area. By default, they open on top of
each other in the size of the full area. The titles of the windows are displayed in tabs at
the top of the area.
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Window_area.jpg

Figure 4.9-1 Window area

Click the selected tab to activate a window and to display it on top.

4.9.1.

Adjusting window placement and docking
If you want to view more than one window at a time, you can position the windows in
several horizontal or vertical tabs.
Vtrin can only display either horizontal or vertical leafs, each with its own tab at the top
of the area. In the previous figure, the lower of the two leafs is marked with a red line.
The window placement and docking can be changed either via the Window menu or via
the window tab pop-up list. The list can be accessed by right-clicking the window tab.
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To move the active window to a new tab of horizontal (vertical) leaf using the Window
menu:
• Select Move to a New Horizontal Leaf (Move to a New Vertical Leaf) from the
Window menu. Other windows are also ordered in horizontal (vertical) tab groups.
To move the active window to the following (previous) horizontal or vertical tab using
the Window menu:
• Select Move to the Next Leaf (Move to the Previous Leaf) from the Window
menu.
Using the window tab pop-up list:

Window_docking_menu.jpg

Figure 4.9.1-1 Moving the active window to a new tab using the pop-up list
Menu item

Description

Close

Closes the current window.

Close All But This

Closes all other windows excluding the current
one.

Prominent

Shows only the current window on the whole
window area. The tabs in the same tab group
are left visible, whereas other tab groups are
hidden. All tab groups are restored when
Prominent selection is deactivated.

Rebalance

Resizes all visible windows. The window sizes
are set equal within all rows and within all
columns.

New Horizontal Tab Group

Creates a new horizontal tab group for the
selected window. If the current tab group is
horizontal, a new tab group is created under the
current group. If the current tab group is vertical,
the tab group is created inside the current window area, which is horizontally split in two.

New Vertical Tab Group

Creates a new vertical tab group for the selected
window. If the current tab group is vertical, a
new tab group is created beside the current
group. If the current tab group is horizontal, the
tab group is created inside the current window
area, which is vertically split in two.
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4.9.2.

Menu item

Description

Move To Next Tab Group

Moves the window to the next tab group. If there
are no more windows left in the former tab
group, it will be dismissed.

Move To Previous Tab Group

Moves the window to the previous tab group. If
there are no more windows left in the former
tab group, it will be dismissed.

Changing window placement with drag and drop
Any window can moved to another position on the window area by dragging it from the
window tab. Place the mouse cursor on top of the window tab and move the mouse while
holding down the primary mouse button. A docking helper will appear in the middle of
the current view area.

Window_docking_helper.jpg

Figure 4.9.2-1 Docking helper

The figure above shows the docking helper, which is used to set a window to a new
position. If the window is dropped on top of any of the four directional white rectangles,
the dragged window is placed inside the target window area. The target window area is
then split between the two windows in the desired direction and order.
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Window_docking_helper_center.jpg

Figure 4.9.2-2 Dropping the window to the center of the docking helper

If dropped to the center area of the docking helper, the dragged window consumes the
whole target window area and the replaced window is hidden under a tab.

Window_docking_helper_sidebar.jpg

Figure 4.9.2-3 Moving a window to a new tab group

Any window can also be moved into a new tab group. This is achieved by dropping the
window onto any of the four docking helper rectangles on the far sides of the window
area. A new tab group is created to the corresponding half of the window area with the
contents of the dropped window.

4.10.

Icons
The following table lists some of the most common folder and window icons found in
the tree. Depending on the application, other icons can also be used.
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Table 4.10-1 Tree icons
Icon

Description
Equipment Model
Maintenance
Report
History
History of current values
Stored procedures
Table, List
System Configuration
SQL view
Column chart
Trend chart
Process diagram
Variable list
Variable list, binary variable
Variable list, integer variable
Variable list, text variable
User definition
General icon for an open folder or window
Display Bases to New Items

The icons of the variables indicate the variable type. Icons are used, for example, in the
variable's Status window.
The following table lists the icons that are used for variables.
Table 4.10-2 Variable icons
Icon

Description
Floating-point variable
Binary variable
Integer variable
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Icon

Description
Text Variable

The status icons and colors indicate the status of the variable's current value. The following table lists the icons and colors, as well as the icons depicting the direction of values.
Table 4.10-3 Status icons, status colors, and icons for the direction of values
Icon

Description

Color

The status icon flashes when the
variable has an unacknowledged
alarm
A critical alarm for the variable
A warning for the variable

Yellow

A notification for the variable

White

Invalid value

Magenta

Questionable value

Violet

Value substituted

Blue

Value OK

Green

Manually entered
Invalid source (reason for the
invalid or substituted value)
Handling blocked (reason for the
invalid or substituted value)
An increasing value, used in the
variable's Status window
A decreasing value, used in the
variable's Status window
A static value, used in the variable's Status window

The chart item icons indicate the item type. They are used in the chart legend and in the
Properties dialog for chart items. Chart items icons include the following:

Menu_chart_items.jpg

Figure 4.10-1 Menu chart
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Table 4.10-4 Chart item icons
Icon

Description

Line, trend

Icon for line plots. The color of the symbol in the icon
corresponds to that of the plot and/or data point markers.
The data point marker color is selectable.

Area

Icon for area plots. The color of the symbol in the icon
corresponds to that of the area and/or data point markers. The data point marker color is selectable.

Stacked area

Icon for stacked area plots. The color of the symbol in
the icon corresponds to that of the area and/or data point
markers.
Icon for stacked column series. The color of the icon
corresponds to that of the columns.

Stacked column
Icon for sorted stacked column series. The color of the
icon corresponds to that of the columns.
Stacked column, sorted
Stacked column where the column color is based on
application status. If application status is not available,
Stacked column, application status the column color corresponds to that of the icon.
Defines the color corresponding to application status.
Application status

Gantt

Icon for Gantt charts. The color of the icon corresponds
to that of the Gantt chart if no color condition has been
defined or the condition is not fulfilled.
The color of a Gantt chart component when the color
condition is fulfilled.

Gantt, status and color

Line, XY scatter

Icon for XY plots. The color of the symbol in the icon
corresponds to that of the plot and/or data point markers.
The data point marker color is selectable.
Icon for text rows. The icon background color is selectable.

Info
Icon for separator rows. The icon color is fixed.
Separator

Marker
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Icon

Description
Shows that an error occurred when fetching chart item
data.

Error indicator

The following table lists other icons used in Vtrin.
Table 4.10-5 Other icons
Icon

Description
Vtrin
User's PC
Server
Icon for the free start and end time of an interval, used, for example, in
charts. Click the icon to lock the time.
Icon for the locked start and end time of an interval, used, for example,
in charts. Click the icon to unlock the time.
Icon for the updated end time of a time span, used, for example, in
charts. Click the icon to lock the time. The time changes into an updated
pin by double-clicking.
Iconizes the window that is displayed with the cursor.
Closes the window.

The shape of the pointer depends on the task and, in the chart area, also on your selections.
The following table lists the pointer icons.
Table 4.10-6 Pointer icons
Icon

Description
Pointer displayed in normal situations when you move the mouse or
point at, for example, a current value or plot in charts. (Arrow selected)
Pointer displayed in normal situations when you move the mouse or
point at, for example, a current value or plot in charts. (Arrow and
crosshair selected)
Pointer displayed in normal situations when you move the mouse or
point at, for example, a current value or plot in charts. (Crosshair
selected)
Pointer displayed when you point at a link in a chart.
Pointer displayed when you copy or move an item by dragging.
Pointer displayed when you drag an item over an area where it cannot
be dropped.
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Icon

Description
Pointer displayed when you change the size of different areas on the
screen.
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5.

Charts
The graphical information in Vtrin displays is shown in charts. Charts can contain various
graphical elements, such as pictures, graphs, plots, value controls, and text blocks.
This chapter describes various properties of the chart display on a trend display template.

Description of charts
The chart window described here covers the chart shown in Figure 5-1. All charts do
not include all the properties described here. The properties can also be located in different
parts of the window.
Charts are located in application-specific tree folders. To open the chart window, click
its icon or name of the tree node.
The chart window described here has the following parts:
• a tab
• a title bar
• a time scroll bar
• a time ruler
• scaling limits
• a plot area
• an interval row
• a legend
The tab displays the name of the chart window. When you point to the name, the program
displays a tool tip that shows the location database of the chart and its call path. A close
button with which you can close the active chart window is located at the right end of
the tab row. The title bar of the chart window shows the company/department name, the
chart title, as well as the current date and time. The chart author specifies the company/department name and the diagram title.
The plot area displays different kinds of trends and column graphs.
The legend contains rows displaying information on the variables in the plot area. It can
also contain text and separator rows.
The scaling limits show the upper and lower limits of the graphs in the plot area.
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Chart window

Chart_Window.jpg

Figure 5-1 Chart window
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Chart window terms

Description

Tab

The text displays the name of the chart.

Plot area

See 5.1, Plot area.

Chart title

The default title of the chart window is the name
that the chart has in the tree. You can edit the
name in the title area, if you have sufficient
rights.

Time ruler

See 5.6, Time scale.

Time scrollbar

See 5.5, Time scroll bar.
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Chart window terms

Description

Current date and time

5.1.

Upper scaling limits

See 5.3, Scaling limits.

Scaling limits

See 5.3, Scaling limits.

Lower scaling limits

See 5.3, Scaling limits.

Locked pin

See 5.4, Time bar.

Legend

See 5.2, Legend.

Time bar

See 5.4, Time bar.

Time span

See 5.4, Time bar.

Pointer value column

See 5.1.3, Viewing trend values.

Free pin

See 5.4, Time bar.

Plot area
The plot area displays the graphs of variables, such as line plots, area plots, and column
series, usually as a function of time.

Description of plot area
The plot area is located below the time scroll bar and the time ruler. A chart window can
contain more than one plot area.

Past_and_Future_Plot_Area2.jpg

Figure 5.1-1 Past and future plot area

The plot area is divided into Past and Future areas, with the red line denoting the present.
A plot area can also be limited to showing the past only, or the future only.
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To view the values of the graph, place the pointer over the graph. The tool tip box shows
the value, time stamp, and status of the data point closest to the left of the pointer (See
5.1.1, Viewing the value of the graph in the tool tip box).
Moving the pointer in the plot area displays the time and all the calculated values of line
and area plots in the pointer's location. The Pointer Value column must be selected in
the legend (See 5.1.3, Viewing trend values).
You can also zoom in to view a certain part of the time span in more detail. Zooming in
moves the left side of the selected time span to the left side of the plot area and the right
side of the time span to the right side of the plot area. You can zoom in repeatedly.
Zooming out cancels the effects of zooming in, step by step. To return to the original
view, zoom out as many times as you zoomed in.
With the chart pop-up menu you can also view summary values of the plots, view trend
values, zoom the plot area, copy data to the clipboard, and change the chart format to
list or graph.

Only those options that are possible for your selection are
active.

Popup_menu.jpg

Figure 5.1-2 Chart pop-up menu
Table 5.1-1 Pop-up menu items
Item

Description

Zoom In

See 5.1.4, Zooming in.

Zoom Out

See 5.1.5, Zooming out.

Summary

See 5.1.2, Viewing summary values.

Execute

Startup of applications defined in the system.

Recalculate

Startup of applications defined in the system.

Copy Data to Clipboard

See 5.1.6, Copying data to clipboard

48

1MRS756739

COM600 series, Version 5.1
Data Historian Operator's Manual

To List

Changes the chart from a graph to a list format. See 5.1.7, Converting chart to list
or graph.

To Graph

Changes the chart from a list to a graph format. See 5.1.7, Converting chart to list
or graph.

Properties...

Open chart definitions.

5.1.1.

Viewing the value of the graph in the tool tip box
•

Point to a part of the graph and wait for a moment. A tool tip, showing the content
of the legend text column (usually a description of the variable) and the unit of the
variable, as well as the retrieved history data (value, time and status), is displayed
next to the pointer. The history data is the data of the data point closest to the left
of the pointer.

Tooltip_and_trend_value_line.jpg

Figure 5.1.1-1 Tool tip and trend value line
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5.1.2.

Viewing summary values

Tooltip_summary_in_trend_2.jpg

Figure 5.1.2-1 Tool tip summary in trend

Click the mouse at the desired location in the plot area. A turquoise vertical trend value
line is displayed in the location of the pointer. Its location is fixed in relation to the plots
and it moves with the plots when they are refreshed.
Cursor time and value rows are refreshed automatically by
clicking the mouse. For example Start time, End time, and
Minimum, however, are caught from the data when the display
is called or when the data is refetched by command. Thus they
are not automatically refreshed.
Table 5.1.2-1 Summary items
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Item

Description

Summary

Right-click in the plot area and select Summary from the popup menu.
The window shown opens. It shows plot values at the trend value line
for all plots on the screen, as well as the minimum, average, maximum,
and deviation values calculated from the plot points.

Start time

Start time from the display call.

End time

End time from the display call.

Cursor time

Time corresponding to the desired location.

Value

Value corresponding to the desired location.

Minimum

Minimum during the time span between the start and end time.

Maximum

Maximum during the time span between the start and end time.
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5.1.3.

Item

Description

Average

Average during the time span between the start and end time.

Deviation

Deviation during the time span between the start and end time.

Viewing trend values
1.

2.

3.

Place the pointer in the plot area and move it so that the vertical line of the crosshair
pointer (assuming that the crosshair has been selected in the chart window) is in the
spot you want to see. The location of the horizontal line is unimportant.
Click the mouse. A turquoise vertical trend value line is displayed in the location
of the pointer. Its location is fixed in relation to the plots and it moves with the plots
when they are refreshed. The time and values in the legend do not follow the pointer's
movements, but instead show the data pertaining to the selected point.
Clicking anywhere in the plot area makes the trend value line disappear. The data
in the legend starts following the pointer movements again.
If you click again in the plot area, a new trend value line with time and variable
values are displayed.

Viewing trend values in variable value points using arrow keys:
1. Select a variable from the legend.
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2.
3.

Click on the chart to select time. Turquoise vertical line appears indicating the
selection.
Left and right arrow keys move the turquoise line from one value point to another
showing new trend value and time for each point.

Pointer_position_value_in_trend.jpg

Figure 5.1.3-1 Pointer position value in trend
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Table 5.1.3-1 Display items

5.1.4.

Item

Description

Trend value line

The trend value line shows the values corresponding to the selected time.

Pointed time

The column shows the values corresponding to
the selected time.

Value corresponding to the pointed time

The column shows the value at the time of the
selected trend value line or, if the line has not
been selected, the value at the time which the
cursor points to.

Zooming in
To define the area you want to zoom in:
1. Place the pointer in the plot area, move it to the left side of the area and press and
hold the mouse button.
2. Drag the pointer to the right side of the selected area. The selected area is highlighted.
3. Release the mouse button.
If the text boxes displayed on the time span row show the start and end time of the
selected area, the history update bar has been defined and you can change the start
and end times.
4. Right-click in the plot area and select Zoom In from the pop-up menu. The selected
time span now fills the entire plot area. The time span is locked, the pins are pushed
down, and the interval and curves are no longer refreshed.

displayterms.jpg

Figure 5.1.4-1 Display terms

To refine the selection, modify the start and end times in the boxes. The highlighted area
changes accordingly.
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Zoom_out.jpg

Figure 5.1.4-2 Zoom out

5.1.5.

Zooming out
1.
2.

3.

Right-click in the plot area and select Zoom Out.
The Zoom Out command can be selected as long as the number of zooms in commands is larger than the number of zoom out commands. To return to the original
state, zoom out until the Zoom Out command is disabled.
Release the time span by clicking pins ( ). This re-enables the refreshing of the
time span and the graphs (at the end double-click, in which case the pin statuses on
the updated display should be

5.1.6.

--

).

Copying data to clipboard

Copy_Data_to_Clipboard.jpg

Figure 5.1.6-1 Copying data to clipboard
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Table 5.1.6-1 Clipboard actions
Action

Description

Copy Data to Clipboard

The Copy Data to Clipboard dialog is displayed with chart popup menu.

Averages

Picks the average values of the chosen intervals.

Begin values

Picks the values at the beginning of the chosen intervals.

Raw data

Picks a chosen number of sample values (with max. count only)

Values with step of

The number of retrieved data samples is defined based on a
time interval (default) The samples are interpolated.

Values with sample count

The number of retrieved data samples is defined based on a
sample count. The samples are interpolated.

Statistics

Exports the data to a statistical application (Not applicable to
raw data).

Time value

The interval used to sample the variable. The default value is
the "width of the column" defined in the display.

Time unit

The unit of interval.

Number of samples

The number of samples taken from the variable.

Show status with HTML format No significance in the Statistical Tool (selected).
Use display format of variable No significance in the Statistical Tool.

5.1.7.

Converting chart to list or graph

Chart_to_list.jpg

Figure 5.1.7-1 From chart to list display

To List: In the chart pop-up menu, the To List -command converts the chart from a
graphic format into a list format.
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List_display.jpg

Figure 5.1.7-2 From list to chart display

To Graph: When in a list format, the To List -command is replaced by a To Graph command. It converts the chart back into a graphic format.
The time interval for retrieving samples is determined in
Properties.

5.2.

Legend
The legend shows data related to variables displayed on the chart area. It can also show
data for items without chart visualization.

Description of legend
The legend is located below or to the right of the chart area. There is always one legend
for each chart.
For trend charts, the legend is usually located below the chart area. This positioning
gives more space for multiple columns.
For column charts, the legend is usually located on the right side of the chart area. This
gives more space for multiple rows.
The graphic type of the variable item is displayed as an icon in the first column of the
legend. The color of the icon is the same as the color of the item in the graph. The icons
are shown in Table 4.10-4.
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The legend can be configured to display a variety of information on the variables, such
as:
• variable names
• aliases
• IDs
• descriptions
• current values
• units of current values
• the names of the tables from which the values of past and future times are retrieved.
In the case of line and area plots, the legend can display the (trend) values in the pointer’s
location.
The legend can include text and separator rows:
• A text row presents variable data without a drawn graph.
• A separator row is a blank row.
The icons for text and separator rows are shown in Table 4.10-4.
You can change the following legend display settings:
• To display columns or item rows that do not fit in the screen area, scroll with the
scroll bar at the bottom or on the side.
• To fit more columns on the screen, reduce the width of each column.
• Change the order of columns by dragging them.
This action does not apply to the icon column, since it
has a fixed position.
•
•

To hide a graph temporarily from the plot area, click the item type icon on the
variable's row. You can display the graph again by clicking the icon again.
Edit the variable of the plot in its column and/or in the history column.

You can select one or several variables for editing. If you select several variables, they
must be located next to each other in the same column of the legend rows.
To select one variable:
• Click the variable column on the row. The selected variable row is now highlighted
and the background color of the selected column is turned darker.
To select several variables:
• Click the outermost (lowest or topmost) variable column on the row you want to
include in the selection. The selected variable row is now highlighted and the
background color of the selected column is turned darker.
• Press SHIFT and click the other outermost variable column of your selection. All
the selected rows are now highlighted.
You can now edit the variables in the column.
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To edit a variable column:
• Select the variables in the column as instructed earlier. An arrow indicating a dropdown menu appears in the last row selected.
• Click the arrow to open the drop-down menu.
• Select a variable by clicking its name in the menu.
• All the highlighted variables are now changed into the variable you selected.

5.2.1.

Pop-up menu
When editing selected variable items, you have the following options in the pop-up
menu: Send to, Execute, Recalculate, Remove, Legend Columns, and Properties.
To edit a selected variable item or to execute a selected function:
• Open a pop-up menu by right-clicking the row.
• Select the desired option from the pop-up menu OR from the function buttons above
the menu.
Only options that are possible for your selection are active.

Menu_legend.jpg

Figure 5.2.1-1 Legend menu
Table 5.2.1-1 Menu items
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Item

Description

Send to

Opens a menu with variable specific displays
defined in the system.

Execute

Startup of applications defined in the system,
see 5.7.2, Scenario operations.

Recalculate

Startup of applications defined in the system,
see 5.7.4, Activating recollection of all variables
in a history table.

Add Marker

Opens a property dialog, where you can add a
new marker to the chart items at a selected
time.
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Item

Description

Remove...

Removes the chart items whose rows you
clicked from the plot area and from the legend
in question.

Legend Columns...

Opens the Legend Columns dialog, where you
can define the data to display in the column and
its order.

Properties...

Opens the chart item’s Properties dialog where
you can edit the item’s properties.

With the function buttons you can change the item visibility, item type, marker type,
limit type, item fill style, and color settings.

Legend_menu_upper.jpg

Figure 5.2.1-2 Functions in the legend
Table 5.2.1-1 Function buttons for adjusting the chart item properties
Button

Description

Buttons in the upper row
Item visibility
Shows the status of visibility (on/off) currently in use. To
change the status, click the button.
Item type
Shows the item type currently in use. To change the item type,
click the button.
Item type options
•
•
•
•
•
•
•
•
•
•
•
•
•

Line, trend
Line, XY scatter
Marker
Area
Stacked area
Stacked column
Stacked column, sorted
Gantt
Gantt, status, and color
Stacked column, application status
Application status
Info
Separator
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Marker type
Shows the marker type currently in use. To change the marker
type, open a pop-up menu from the right corner arrow.
Marker type options
•
•
•
•
•
•
•
•
•
•

No marker
Rectangle
Diamond
Triangle
Ellipse
Diagonal cross
Cross
I-Beam
Vertical
Horizontal

Scaling limit type
Shows the scaling limit type currently in use. To change the
limit type, open a pop-up menu from the right corner arrow.
Scaling limit type options
•
•
•

Individual
Automatic
Common

Properties
Press Properties to open the Properties window.
Buttons in the lower row
Item fill style
Shows the item fill style currently in use. To change the item
fill style, open a pop-up menu from the right corner arrow.
Fill style options
The pop-up shows the fill style options and the icons related
to these options.
•
•
•
•
•
•
•
•
•
•
•
•
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Solid
Horizontal Slide
Vertical slide
Upward diagonal slide
Downward diagonal slide
Upward diagonal wave slide
Downward diagonal wave slide
Highlight
Horizontal highlight
Vertical highlight
Horizontal lines
Vertical lines
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Color information (Item color / Item secondary color / Chart
background color)
The three color boxes show the following information (from
left to right):
• Item color: the color in which the selected item is presented
in the chart.
• Item secondary color:
• Chart background color: the color in which the background
of the chart is presented.

5.2.2.

Legend columns

Legend2.jpg

Figure 5.2.2-1 Legend

The data available for the legend is determined by the data sources specified on chart
definitions. The calculated data is available from RTDB process history only.
Changing the order of legend columns
You can change the order of columns by pointing a column heading and then dragging
the column either to right or left in the table. Exceptionally the column of the item, icon,
and the subcolumns for the limits and statistics are fixed.

List_sorting_titles.jpg

Figure 5.2.2-2 List sorting titles

The following tables describe the legend data associated with the data retrieved from
the database via the chart. Different types of charts produce different default settings for
the legend.
On a chart display, a single plot item can comprise the data of one or two past and future
time parameters set, including, for example, the variable and history table from which
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the variable data is retrieved. As the column headings are often the same, an additional
attribute related to the heading is used to specify the data source as follows:
Table 5.2.2-1 Abbreviations used in the legend column headers
Abbreviations used in the legend column headers
F = Future
P = Past
I = Item

For general graph types, the headers of the columns related to the first history data (e.g.
"Variable") and the headers of the respective calculated value columns (for example,
"Average") are shown without any abbreviation ("P", "I"). The headers related to the
first future data begin with the letter "F" (for example, "F Variable" ).
The second history data and the second future data are used only for the "XY-scales"
and the "Ordered stacked column" graph types. The abbreviations in these cases are "P2"
for the second history data headers and "I2" for the headers of the calculated value
columns of the second history data. The abbreviation "F2" (for example, "F2 Description
(Variable)") specifies the columns related to the second future data.
The columns that are typically used in a legend are related to the first history data and
the respective calculated values (see Table 5.2.2-2).
Table 5.2.2-2 List of the generally used columns in the legend
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Column header

Description

Item icon

The item’s type as an icon. The column position of this is fixed. The icons
used are described inTable 4.10-4 in 4.10, Icons.

Text

The variable’s description in the database, if the data is retrieved from
process history; otherwise the search specification (source and retrieved
attributes) or a freely selected text created by the definer.

Description

A description text for the variable (or the history where the data is retrieved
from).

Variable

The variable’s name in the database. You can change the active variable
here.

Alias

The alias of the variable in the database.

Unit

The unit of the variable’s current value in the database.

History

The history table where the data is retrieved from. You can change the
active history here.

Current value

The variable’s updated current value.
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Column header

Description

Pointer value

If trend values have been requested for the chart, the time pointed to is
displayed in the column heading and the column’s rows show the corresponding calculated values.
For linear plot styles, the trend value is created by interpolating. If step
styles, the trend value is the actual value of the point.
The unit of the trend value in the sum and integral tables does not equal
the unit of the current value shown in the legend.

Lower limit

The individual lower scaling limit of the variable’s plot area.

Upper limit

The individual upper scaling limit of the variable’s plot area.

Average

The average of the values retrieved to the screen.
This value is not refreshed automatically on the screen.

Deviation

The deviation of the values retrieved to the screen.
This value is not refreshed automatically on the screen.

Minimum

The minimum of the values retrieved to the screen.
This value is not refreshed automatically on the screen.

Maximum

The maximum of the values retrieved to the screen.
This value is not refreshed automatically on the screen.

Filter

The filtering syntax currently applied to the variable. See 5.2.3, Using the
filter functionality for more information.

Table 5.2.2-3 Activation buttons
Button

Description
To temporarily hide an item and its subitems in the plot area, click its
icon in the legend. The icon changes into the same color as the background while the item row is dimmed. Clicking the icon again displays
the plot and the row is visible again.
Subitem is a limiter statistic item associated with a main item. All its
parameters are defined on the main item. The icon of the subitem shows
its graph style in the plot area.
To temporarily hide the subitem in the plot area click its icon in the
legend. Clicking the icon again displays the plot.
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Button

Description
You can drag the legend’s items (rows) to change their order. This also
changes the order of curves in the plot.
This is useful, for example, if the plot of a variable you want to view is
behind other plots.
You can also temporarily hide the plot that covers the one you are
interested in or change the plot area limits of variable items.
Buttons used to hide or reveal the 'Limits' and 'Statistics' items.

5.2.3.

Using the filter functionality
The filter column provides a very flexible interface for modifying the display of any of
the selected variables. The key principle is that the user can define a filter to perform
the desired operations by typing in the keywords defined in the filter syntax. The syntax
and keywords are described in the following paragraphs and tables.
The syntax consists of a filter selection part and the time period part. For example
"AVG10MIN" calculates and shows the averages over ten minute time spans. Several
filters can also be applied one after another. They are separated with the symbol "|", for
example "AVG1MIN|MAX1H" produces the hourly maximum values from the one
minute average values.
Vtrin automatically changes history tables, if this optimizes
the search. You can set off this optimization by starting with
an empty filter, that is, the "|" sign. For example, "AVG1MIN"
is optimized while" |AVG1MIN" is not optimized.

To enter the desired filter syntax, double-click the filter field of the selected variable.
This opens the field in editing mode. You can now type in the desired filter. A dropdown menu appears after the first character is typed showing all filter keywords beginning
with the letter. Erase all letters typed to retrieve all available filter types.
To remove the filter press Delete or erase the field empty and press Enter.
If no time period is defined, the filter takes the whole visible time period as input. Thus,
for example, "AVG" produces the average over the selected time period. To apply the
filter with a selected time period append the filter syntax with a number and one of the
pre-defined time identifiers. For example, "AVG10MIN" returns the ten minute averages
for the selected time period.
Table 5.2.3-1 The set of available filters
AAVG
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ADEV

Arithmetic Deviation

ADEVP

Arithmetic Deviation of Entire Population

AMEDIAN

Arithmetic Median

AMODE

Arithmetic Mode

AVARIANCE

Arithmetic Variance

AVARIANCEP

Arithmetic Variance of Entire Population

AVG

Time Weighted Average

AVGRAW

Raw Time Weighted Average - ignoring the invalidity of values

CALC

User Defined Calculation. E.g. CALC(y*2) returns values doubled and
CALC(y > 0 ? 10:20) returns 10 if y > 0, otherwise return 20. See the chapter
below for supported constants and functions.

COUNT

Count of Samples Within Period

COUNTG

Count of Good Samples Within Period

COUNTI

Count of Invalid Samples Within Period

COUNTQ

Count of Questionable Samples Within Period

COUNTS

Count of Substituted Samples Within Period

CONVERT

Converts Values to User Specified Unit, for example CONVERT(hp) can
be used to get horse powers out of kilowatts.

CUMSUM

Cumulative Sum

CUMSUMTODOUBLE

Cumulative Sum to Double Value

DELTA

Last Sample In Period minus First Sample In Period

DEV

Time Weighted Deviation

DUR

Duration = Period Length (changes only upon daylight savings or with month
periods)

DURG

Good Duration as a TimeSpan Within Period

DURI

Invalid Duration as a TimeSpan Within Period

FIRST

First Value of a Period

FFT

Fast Fourier Transform of input data

HISTOGRAM

Histogram of input data

INTSEC

Time Integral in Seconds

INTMIN

Time Integral in Minutes

INTHOUR

Time Integral in Hours

LAST

Last Value of a Period

MAX

Maximum Value of a Period, TimeStamp is the Value Time

MAXPT

Maximum Value of a Period, TimeStamp is the Period Time

MIN

Minimum Value of a Period, TimeStamp is the Value Time
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MINPT

Minimum Value of a Period, TimeStamp is the Period Time

OPTIME

Operating Time. Requires a parameter, e.g. OPTIME10MIN(>5) calculates
the time the value has been greater than 5.

PERG

Percent of Good Samples (0-1)

PERI

Percent of Invalid Samples (0-1)

RANGE

Maximum Value Within a Period minus Minimum Value Within a Period

STABILITY

Stability Graph

STARTUP

Startup Count - requires a parameter. E.g. STARTUP5MIN(>5) calculates
the number of occurrences the value has increased from less than or equal
to five to greater than five

SUM

Sum of Values Within a Period

SUMRAW

Raw Sum - Ignoring the Invalidity of Values

SUMTODOUBLE

Sum of Values Within a Period Calculated to Double - Use If There is a
Risk of Overflow

VARIANCE

Time Weighted Variance

WHEN

Conditional fetch of values. Returns requested values when given conditions
are greater than zero.
Syntax: WHEN(Class=...;Property1=...;Property2=...; ...etc... PropertyN=...;xProperty=...;yProperty=...;Filter=...)
See Using the WHEN Filter for more detailed information.

Table 5.2.3-2 The set of available time identifiers
Time identifier

Description

TICKS, HUNDRED- Hundred nanoseconds
NANOSECONDS
MICROSECOND, Microseconds
MICROSECONDS
MS, MSEC, MILLI- Milliseconds
SECOND, MILLISECONDS
S, SECOND,
SECONDS

Seconds

MIN, MINUTE,
MINUTES

Minutes

H, HOUR, HOURS Hours, local time
H_UTC,
HOUR_UTC,
HOURS_UTC

Hours, UTC time

D, DAY, DAYS

Days, local time

D_UTC, DAY_UTC, Days, UTC time
DAYS_UTC
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Time identifier

Description

MON, MONTH,
MONTHS

Months, local time

MON_UTC,
MONTH_UTC,
MONTHS_UTC

Months, UTC time

Y, YEAR, YEARS

Years, local time

Y_UTC,
YEAR_UTC,
YEARS_UTC

Years, UTC time

PL, PLEN, PERIODLENGTH

Source data period lengths. E.g. if the source data is AVG5MIN, AVG2PLEN
produces data that has been averaged over 10 minutes (AVG5MIN |
AVG2PLEN equals AVG10MIN).

Supported constants and functions in the CALC Filter
Supported constants:
• y = the current y value
• x = the current x value
• PI = pi
• e = natural logarithmic base
• prevy = previous y value, for the first value in result set this is the same as y
• prevyz = previous y value, for the first value in result set this is zero
• prevx = previous x value, for the first value in result set this is the same as x
• prevcy = previous calculated y value (result of the calculation of previous values)
• periodlength = period length in 100 nanosecond units
• goodtime = time the value has not been invalid (representativeness affects too)
• meantime = x-prevx
Supported functions:
• abs(x) = absolute value of x
• acos(x) = arcus cosine of x
• asin(x) = arcus sine of x
• atan(x) = arcus tangent of x
• ceiling(x) = x rounded to next greater integer value
• cos(x) = cosine of x
• cosh(x) = hyberbolic cosine of x
• exp(x) = returns e raised to specified power
• floor(x) = x rounded to next smaller integer value
• log(x, y) = returns base y logarithm of the specified number
• log10(x) = returns base 10 logarithm of the specified number
• max(x, y) = if x > y, returns x, else y
• min(x, y) = if x < y, returns x, else y
• pow(x,y) = returns x raised to power of y
• rand(x) = returns a random number from 0 to x
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•
•
•
•
•
•
•
•
•
•
•

rem(x, y) = returns the remainder of x divided by y
round(x) = rounds x to closest integer value
rounda(x, y) = rounds x to y decimals, away from zero
rounde(x, y) = rounds x to y decimals, to even
sign(x) = returns 1 or -1 depending on the sign of the number
sin(x) = sine of x
sinh(x) = hyperbolic sine of x
sqrt(x) = square root of x
tan(x) = tangent of x
tanh(x) = hyperbolic tangent of x
truncate(x) = truncates the decimal part of the x away

Using the WHEN Filter
The WHEN Filter can be used for conditional fetch of values. The filter returns the
requested values, when conditions given as arguments are greater than zero.
Syntax: WHEN(Class=...;Property1=...;Property2=...; ...etc... PropertyN=...;xProperty=...;yProperty=...;Filter=...)
No argument is compulsory. There can be 0-N properties of the given class used as
conditions. Default value for "Class" is "ProcessHistory", which is used, if the "Class"
argument is left empty. Available classes are the same as the sources for a trend. Properties
are the same as the properties for the trend sources. For example, a first property can be
"Variable" and a second property can be "History" for the "ProcessHistory" class. Filter
can be any valid filter operation.
Example use 1:
WHEN(Class=ProcessHistory;Variable=SYS_CPU_TotalTime;xProperty=Time;yProperty=Value;Filter=CALC(y>20))
The clause above returns the "CPU Total time" variable's values when the value is greater
than 20.
Example use 2:
WHEN(Variable=SYS_CPU_TotalTime;Filter=CALC(y>20))
Returns the same values as Example 1, as the only difference is the lack of default values.
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Calculated Trend

Calculated_value.jpg

Figure 5-1 Calculated value

You can create new variable items that are calculated from the data of the existing variables. In our example, variable H is the sum of A and C.
If the time span contains both past and future, the calculated
variable will not be displayed as a graph.

5.3.

Scaling limits
The limits determine the scaling of plots.

Description of scaling limits
The scaling limits are displayed on the left side of the chart. If there are several charts,
each has its own area for limits.
The scaling limits can be displayed in two ways: with the upper and lower limits of
scaling displayed in the boxes, or by using scales whose end points correspond to the
upper and lower limits.
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The graphs in the chart window can have either common or individual limits. For
explanations, see Table 5.3-1.
Individual and common scaling limits can be changed by using boxes or at the ends of
the scales.
The upper limits are located at the top and the lower limits at the bottom of the scale
area. The values of variable items are scaled so that the value corresponding to the upper
limit is drawn at the top of the plot area and the value corresponding to the lower limit
is at the bottom of the area. If the curve exceeds the upper limit or falls below the lower
limit at some intervals, the graph is not drawn on these intervals.
If scaling is depicted using scales, the common limits are displayed on a black scale.
The scale for graphs with individual limits is shown in the same color as the graph.

Limit scales

Limits.jpg

Figure 5.3-1 Limit scales

The following table lists the limit scales.
Table 5.3-1 Limit scales
Field

Description

Upper limits

The upper scaling limits are located at the top.

Lower limits

The lower scaling limits at the bottom.
Limit presentation option
= upper and lower limits enabled
= scale enabled
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Field

Description

Common limit

The common upper scaling limit is the highest upper limit, while the
common lower scaling limit is the smallest lower limit.
Common limits are only displayed if they are used in one of the graphs
and if no individual limits have been defined for the plot.
The common limit values can be changed by entering a new value in
the box.

Individual

The individual upper and lower scaling limit of the curve.
Individual limits are marked in the boxes with a small triangle, the color
of which is the same as that of the graph.
To change the individual limit value, enter a new value in the box.

Automatic limit

Automatically calculated individual upper and lower scaling limits of the
plot.
If automatic scaling is used for the variable, the variable's limits are
calculated automatically and cannot be changed.
The background color of the box for automatic limit is gray.
Also common limits can be automatically calculated. When
they are automatically calculated, the background color is
gray and the values are defined with the help of the minimum
and maximum values of the graphs.
For uptime variables automatic and individual limits need to
be used in order to get the correct time format visible in the
limit indicators.

If several graphs are added to the same chart, the scale limits are displayed on both sides
of the chart. The first is depicted on the left, the second on the right, the third on the left
again, and so on. The following figure shows a chart with three graphs, each using individual and automatically set scaling limits.
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Trend_scaling_limits_3_variables.jpg

Figure 5.3-2 Chart with three graphs

The following figure shows a chart with two graphs. The scales are now visualized with
upper and lower limits only. The yellow graph uses manually set limits visible on the
right side, whereas the orange graph uses automatic scaling, as the grey limit value boxes
on the left reveal.

Trend_scaling_limits_upper_and_lower2.jpg

Figure 5.3-3 Chart with two graphs
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5.4.

Time bar
The time bar allows you to select the time range for displaying the plots of the variables.

Description of time bar
The time bar is displayed under the plot area. It shows the start time of the time span at
the left end of the row and the end time at the right. The length of the time scale of plots
equals the difference between the start and end times.
The current time, which means the current time on the server, is located at the right end
of the time span but can also be located in the middle or at the left end so that the time
span stretches into the future.
The plot values displayed on the left of the current time are retrieved from the source
table for history data. They can be average or current values. The plot values shown on
the right of the current time are retrieved from the source table for future data, which is
usually a prediction table. This requires that a prediction table has been configured into
the system.
A red vertical line in the plot area signifies the current time (see Figure 5.4-1). The future
area to the right of the line is highlighted by dimming the background.

Time_bar_current_time_indicator.jpg

Figure 5.4-1 Time bar display

Both ends of the time bar have a pin icon, which can have any of the following states:
The time next to the pin is updated (only used at the right end)
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The time next to the pin is unlocked
The time next to the pin is locked

The display's update mode is determined in the following way, depending on the left
and right pin:
Normally updated display. If the time span is changed, the time scale
and the time at the left end of the time span change accordingly and the
display continues to be refreshed.

--

Unrefreshed display. If you change the time span, both times change
by an amount equal to half of the modified time difference and the time
scale changes.

--

--

or

--

--

--

Unrefreshed display. If you change a locked time, the time scale moves
by an amount equal to the modified time difference. If you change the
time span, the unlocked time moves by an amount equal to the modified
time difference and the time scale changes.
Unrefreshed display. If you change a locked time, the time scale changes
by an amount equal to the modified time difference.
The display is updated and the time scale keeps expanding . If you
maintain a locked time, the time scale changes by an amount equal to
the modified time difference and the display continues to be updated.
The display causes a load on the system.

Time bar

Time_bar_row.jpg

Figure 5.4-2 Time bar

Table 5.4-1 Time bar display terms and buttons
Button

Description

Time span

The time span – that is, the difference between the start and
end time – is displayed in the boxes in the middle of the time
bar when at least one of the time span’s ends is unlocked
or updated
. The value and unit of the interval are displayed
in their own text boxes. To change the interval, change either
the value and/or unit. An inexact interval is indicated in the
following way:
The graphs are redrawn after each change.
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Button

Description
Free start or end time that cannot be changed.

Start time
You can change the locked start or end time to view the graph
at different times and to use a longer or shorter time span.

End time

A locked start or end time that can be changed. The indicator
for daylight saving time is displayed on the right side of the
time. A check mark in the box indicates daylight saving time.
Usually the indicator, either checked or unchecked, is disabled. When the time stamp falls in the one-hour interval
during which we move from daylight saving time to standard
time, the indicator box is not disabled, allowing you to specify
whether the time stamp refers to daylight saving or standard
time.
To lock the time, click the pin.

Updated pin
To lock the time, click the pin. Double-clicking moves time to
Free pin

the update status (

).

To release the time, click the pin. Double-clicking moves time
Locked pin

5.5.

to the update status (

).

Time scroll bar
The time scroll bar allows you to select the time for which the graphs of variables are
presented in the chart.

Description of time scroll bar
The time scroll bar is located above the plot area. The location of the scroll bar indicates
the location of the chart. Past time is to its left and future time to its right.
When the chart window is opened, the chart area on the left side of the scroll bar represents the available past time area, while the chart area on the right side represents the
available future time area. The time areas correspond to the maximums of the past and
future times of all the variable items in the chart based on the source tables defined for
the variables.
To view the graphs at different times, move the scroll bar. The time span remains
unchanged. Moving the scroll bar locks the end time, and the graphs are no longer
refreshed. To return to the original chart view, unlock the end time in the time bar.
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Time scroll bar

Time_scroll_bar_row.jpg

Figure 5.5-1 Time scroll bar

The following table lists the Time scroll bar buttons
Table 5.5-1 Time scroll bar buttons
Button

Description
The time span for which the curves are displayed moves backwards or
forwards in time when you move the scroll box.

Scroll bar

The start and end times of the time span change to correspond to the
new location of the chart in the available time area. The time span
remains the same. The end time is locked, the pin is pushed down ( )
and the graphs are no longer refreshed.
Double-clicking the pin to unlock an end time (
original view.

) returns you to the

The pin is updated (
), the scroll box moves to its original location
and the graphs are refreshed again.

5.6.

Time scale
With time scale you can set limits for the time span used in the chart.

Description of time scale
The time span setting area is located below the plot area. It consists of a start time
indicator, drop-down menus with which you can set the time span used and an end time
indicator.
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Time_scale_whole_2.jpg

Figure 5.6-1 Time scale

•

Start time shows the earliest time the chart shows.

•

The drop-down menus show the numerical value and the time span unit selected for
the time span. You can change either the numerical value or the unit from the menus.

•

End time shows the latest time the chart shows.

Setting time scale
You can set the time span from the two drop-down menus:
1. Set the numerical value that shows how many of the selected units are shown.
To select a numerical value:
• Select the correct value from the drop-down menu on the left.

2.

The options are:
• Select the desired option by clicking its row.
Select the unit (for example seconds, minutes).
To select the correct unit:
• Select the option you want from the drop-down menu on the right.
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•

Select the desired option by clicking its row.
If the selected numerical value does not match exactly with
the selected unit, the numerical value is rounded to a matching
value closest to the original.

5.7.

History updating and recollection
Values in the history tables can be updated e.g. to correct possible errors or to insert
missing values. To correct history data, you can update the values in history tables and
activate so called recollection to compute the calculated variables and transformations.
This propagates the changes to all affected history tables. You update the values of a
variable in a history table for either a selected time span, single value or a single point
in a chart window, that displays the variable values from the history table.
The updating functions are:
• adding new values
• replacing existing values
• deleting existing values
From history updating point of view, there are two kinds of history tables: periodic and
nonperiodic. After you have updated the values of all variables you want to correct, you
can activate recollection for all variables in the history table for this time span. This can
be done in any chart window. Depending on the recollection definitions in the RTDB,
the recollection may be cumulated for all higher-level history tables.

5.7.1.

Updating values of a variable in a history table
•
•
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Open a chart window that presents values of the variable you want to update (in the
example charts, the data points are marked for clarity).
Click the variable in the legend to select it, and then select the time span you want
to update. After the selections, the system shows the start and end values of the
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•

selected time span as the default values. You see them in the value boxes next to
the time span start and end times.
If you change your selection, the value boxes show new default values.

HistoryUpdating_CurrentHistoryTrend.jpg

Figure 5.7.1-1 Trend of a variable from a non-periodic table
Display term

Description

Start value

The value used as the start value for a time
span based history value updating. Initialized
with the value of the variable at the start time of
the time span.

Start time

The start time of the time span.

End time

The end time of the time span.

End value

The value used as the end value for a time span
based history value updating. Initialized with the
value of the variable at the end time of the time
span.
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•
•

If you want to change the values, enter new values in the value boxes.
Clear the values from the value boxes, if you want to remove the history values.
You can remove the values also from the Graph Area pop-up menu by the selection
‘Remove Time Span Values...’

GraphAreaPopUpMenu2.jpg

Figure 5.7.1-2 Graph Area pop-up menu

To activate the updating, click the Commit button. After pressing the button, the Confirm
History Updating dialog box shows up with the following information:

ConfirmCurrentHistoryUpdating.jpg

Figure 5.7.1-3 Confirm History Updating dialog

•
•

•
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Optional Comment is stored into the history update log. The maximum length for
the comment is 80 characters.
Check box Allow overwriting the values after updating controls the later handling
of the updated values. If this option is selected, the transformations that will be
calculated in this table will overwrite the values that you manually updated.
Click OK to activate updating or Cancel to cancel it.
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Updating non-periodic history values
Update or delete operation inserts new data points immediately before (-100ns) the start
time and immediately after (+100ns) the end time of the time span and assigns them to
the original values at those time positions, and then removes values that the time span
covers. Updating then also adds the values specified in the value boxes.
If the history table to be updated is CurrentHistory and the value to be inserted is newer
than the newest history value of that variable, then the new value goes through the current
value processing. Otherwise the values are put directly into the target table.

CurrentHistoryTrendAfterUpdating.jpg

Figure 5.7.1-4 Current history trend after updating
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The effect of the history update is seen as a straight line from the start value to the end
value and as the additional value points just before and after the selected time span.

CurrentHistoryTrendAfterDeletion.jpg

Figure 5.7.1-5 Current history trend after deletion

The effect of history value deletion is seen as an empty region from the left additional
value to the right additional value. The highlighted area remains selected and you can
update the values of another variable on the same time span. To do so, continue by
selecting the desired variable from the legend.
In addition to the time span based updating there are two more ways to update history
values:
• Inserting, replacing or deleting a single data value of a history table. These are initialized with a single click on a chart. The system responds by showing a vertical
line on top of the chart. The time and the corresponding default value are shown on
the time bar.
• Replacing or deleting a single data point of a history table. To initialize these options,
set the cursor on a chart so, that the tool tip of the value to be updated becomes
visible. Then hold down the Shift-key and click. The system responds by highlighting
the range, which begins from the shown data value and ends just before the next
data point of the variable or at the right end of the chart. The default value and the
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corresponding time are shown in the time bar. In this case the update function
replaces or deletes the value, which is in the beginning of the highlighted area.

Updating periodic history values
The update procedure for values in periodic type history tables is slightly different from
the updating of a non-periodic table. The following figure shows an example of a periodic
type average, a value table. The variable type is selected as before. However, while
selecting the time span, the system expands the time span to cover full period lengths
regardless of the original selection.

AverageTrend2.jpg

Figure 5.7.1-6 An average value table
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If start and end values are different, the update function produces new values for every
time period using interpolation.

AverageTrendAfterUpdating.jpg

Figure 5.7.1-7 An average value table after updating
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If start and end values are equal, the update function produces a value only to the
beginning of the first period within the time span.

AverageTrendAfterUpdatingPacked.jpg

Figure 5.7.1-8 An average value table after updating with new values in the beginning of the time span
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If a value is deleted, the update function removes the values covered by the time span.

AverageTrendAfterDeletion.jpg

Figure 5.7.1-9 An average value table after deletion
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The following figure shows an example of a periodic type, the sum of values. The default
values suggested by the system are equal in this case.

SumTrend.jpg

Figure 5.7.1-10 The sum of values
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In case of sum of the values, the update function produces equal values every time period
covered by the time span.

SumTrendAfterUpdating.jpg

Figure 5.7.1-11 The sum of values after updating

The following figure shows an example of updating a scenario table data. The example
shows three trends for the same variable: one from the base table (white), one from the
scenario table (red), and one which is combined from the previous two (black). The
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combination takes values primarily from the scenario table. If there is no value available,
the value is taken from the base table, if available there.

ScenarioTrend.jpg

Figure 5.7.1-12 Scenario table data
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Updating the combined trend always changes the values in the scenario table, as shown
in the following figure. Deletion removes the values from the scenario table as well.

ScenarioTrendAfterUpdating.jpg

Figure 5.7.1-13 Scenario table after updating

5.7.2.

Scenario operations
In addition to scenario table updating, some scenario specific operations are available.
A history table can have one or more scenario tables related to it, but a scenario table
can be connected to only one history table. The name of a scenario table is the name of
the history table with a scenario suffix as follows:
•
•
•
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fixed scenario identifier: ‘_SC’
scenario number: one or more numeric characters, e.g. ‘123’
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The full scenario table name for this example according to this rule is: ‘HT_SC123’.
There is also a separate table ‘Scenarios’ for scenario handling in the system. This table
connects the scenario number to the scenario name which is shown on the legend rows
and related dialog boxes.
The four scenario specific operations are available through the Legend Row or the Graph
Area pop-up menu:

ScenarioOperations2.jpg

Figure 5.7.2-1 The Graph Area pop-up menu

These operations should be activated by right-clicking the legend row which has the
appropriate scenario table and base table combination configured, i.e. base table with
option. If activated elsewhere, the user has to set the scenario and base tables properly.

Scenario clearing
This operation completely clears all the scenario tables that have the same scenario
number in their table name as the selected scenario table has (in the following example
picture the scenario table related to Option 3 determines the scenario number).
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ScenarioClearing.jpg

Figure 5.7.2-2 Scenario clearing operation

Scenario commitment
This operation combines data from the defined scenario and base tables within the time
span, and stores that data to the base table. The original data in the base table is removed.
This operation concerns all variables.

ScenarioCommitment.jpg

Figure 5.7.2-3 Scenario commitment operation
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Copy to Scenario
This operation copies all rows of all variables within the time span from the base table
to the scenario table. The original data in the scenario table is removed before copying.

CopyToScenario.jpg

Figure 5.7.2-4 Copy to scenario operation

Delete from Scenario
This operation removes all rows of all variables within the time span from the scenario
table.

DeleteFromScenario.jpg

Figure 5.7.2-5 Deletion of all variables from the scenario table
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5.7.3.

History Update Log
Each update and deletion or scenario operation generates a new row to the History
Update Log table. A row contains information about the target table and variable,
updating time, time span and corresponding values, and what was the updating operation.

HistoryUpdateLogRow.jpg

Figure 5.7.3-1 History Update Log table

5.7.4.

Activating recollection of all variables in a history table
Recollection (includes recalculation) is performed for all variables for a selected time
span. Recollection requires that recalculation and recollection definitions have been
specified in RTDB. They define which history tables are recollected. When the recollection is activated, you specify the history table and a time stamp indication where data
has been updated. The recollection will then compute all variables and upper level history
tables that depend on the defined source table. For example, when some source values
in one hour average level have been modified, the one hour level recalculation will calculate the variables that depend on the source variables. After that, the one day average
values are recollected from the one hour level values, and so on.
•
•
•
•

Open a chart window that shows the time axis and the time span bar.
Change the time span of the window so, that it covers the time span that will be
recollected, if necessary.
Select the part of the time span, that will be recollected
Right-click in the graph area to open the Graph Area pop-up menu:

RecalculationActivation.jpg

Figure 5.7.4-1 The Graph Area pop-up menu
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Click Recalculate on the menu to open the History recalculation activation dialog:

HistoryRecalculationActivation.jpg

Figure 5.7.4-2 The History recalculation activation dialog

•

•

Select the history table from where (selected table included) the recollection is
activated. If a variable was selected in the legend when you clicked Activate
Recollection…, the source table for the past specified for that variable is shown as
the default table. Depending on the RTDB definitions, the recollection may be
cumulated to all higher level history tables.
Click OK to activate the recollection or Cancel to cancel.

The recollection may take a while. RTDB has a diagnostic variable
RTDB_HRQUEUELENGTH that indicates the length of the current recollection queue.
When its value reaches zero, the recollection is ready (however, if other recollection
requests are constantly being done, the value may never reach zero). The execution and
completion of the recollection tasks can also be monitored through the MessageLog
messages from the RTDB-Scheduler.
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6.

Process diagrams
Process diagrams present current and history values refreshed in the process-specific
background as values, columns, symbols, or plots. Process diagrams are displayed in
chart windows.

Description of process diagrams
Process diagram windows are usually located in the application-specific folders of the
tree. To open the window, click its icon or name.
The process diagram window usually contains a tab at the top, the diagram's title row,
and the actual process diagram.
The tab displays the name of the chart node in the tree. When you point to the name on
the tab, a ToolTip is displayed. It shows the location database of the chart node and its
call path. A Close button used to close the active chart window is located at the right
end of the tab row. The diagram's title bar shows the diagram's title, as well as the current
date and time.
The process diagram area displays a fixed process background, as well as updated process
data in the form of values, columns, symbols, or plots (as sub-diagrams). It may also
contain links to other figures, either as an individual link text or linked to current values
and symbols.
Sub-diagrams, values, columns, symbols, and links are presented in boxes, whose size
can be modified.
For more information on the information displayed in the process diagram window, see
the following chapters:
• Sub-diagrams: 6.1, Sub-diagrams
• Values: 6.2, Current values
• Columns: 6.4, Bars
• Symbols: 6.5, Symbols
• Links: 6.6, Links
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Example_process_diagram.jpg

Figure 6-1 Sample process diagram

6.1.

Sub-diagrams

G_sub_diagram.jpg

Figure 6.1-1 Sub-diagram

Sub-diagrams can contain a background, a refreshed line, and area plots or column series
on top of it. The direction of time of the series can be defined right, down, up, or left.

6.2.

Current values
The value field shows the current or history value of the variable. In addition to the value,
you can indicate the unit of the variable's current value and value status with a statusspecific color or icon, as well as the unacknowledged status of an alarm associated with
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a current value with a flash. The icon can be displayed at all times or only when the
status is not OK.

Current_value_and_tooltip.jpg

Figure 6.2-1 Current value

Pointing to the value displays a ToolTip. The ToolTip shows the description (or updated
text) of the variable, the growth direction of the value (+/=/), the current value unit, time
stamp, status, and short trend.

6.3.

History values
There is no trend in a history value, because the data is only available from even periods.
The unit is correct as averages, but not as sums. The end of the variable name is the name
of the history table.

History_value_and_tooltip.jpg

Figure 6.3-1 History value

6.4.

Bars
The bar shows the current or history value of the variable. In addition to the value, you
can indicate the unit of the variable's value and value status with a status-specific color
or icon, as well as the unacknowledged status of an alarm associated with a current value
with a flash. The icon can be displayed at all times or only when the status is not OK.
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Bar_graph_and_tooltip.jpg

Figure 6.4-1 Bar with current history and variable of the value

Pointing to the bar displays a ToolTip. The ToolTip shows the description (or updated
text) of the variable, the growth direction of the value (+/=/), the current value unit, time
stamp, and status.

6.5.

Symbols
Refreshed symbols are used to present binary variables. The form of the symbol represents
the value (binary state) of the variable - for example, valve open/closed or pump on/off.
Symbol groups can also be defined in the symbol library so that part of the symbol is
shown in the color of the state (e.g. OK, invalid, replaced, alarming). In this case you
can also define the state of the value to be indicated by a color or an icon (and also color).
The state icon can be displayed at all times or only when the state is not OK. The unacknowledged status of an alarm associated with a current value is indicated with a flash.
Figure 6.5-1 shows different representations of the valve symbol and a ToolTip, which
provides a description (or updated text), and information on the value, time stamp, and
status of the variable.

Symbol_and_tooltip.jpg

Figure 6.5-1 Valve symbol and a tooltip
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6.6.

Links
The name of the window link is displayed in blue and underlined, assuming the color
and underlining settings of the link have not been changed. When you point to the link,
the pointer changes to one resembling a hand and displays a ToolTip that shows the
location database of the window to be opened, call path and name. Clicking the link
opens the window on screen.

Link_and_path.jpg

Figure 6.6-1 Link and a tooltip
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7.

Lists
List windows show database data (attributes) in list format. Examples of lists include
the variable list, alarm log, event log, maintenance log, and user log. Basically all lists
are viewed in the same way. Some lists, however, can contain more properties than
others. This chapter uses the variable list as an example.

Description of lists
The list name is displayed on the tab. When you point to the list name, a tool tip that
shows the location database of the list and call path are displayed. A search bar, an
advanced search bar, and the column headings are displayed at the top of the list window,
while scroll bars are displayed on the right and at the bottom. Depending on the list
configuration, the search and advanced search bars can be visible or hidden.
The list area displays the list items. Examples of items include the variables of the variable
list and events of the event log. The list has one row with columns for each item. Rows
can be browsed with the scroll bar on the right and columns with the scroll bar at the
bottom. If a row has been enabled, there is a number in front of it.
Column headings show the names of the columns in the list. You can sort the items based
on the information on 1-5 columns (unless this has been prevented in the list configuration). A small triangle in the column heading indicates that the items have been sorted
based on the column in question. The direction of the triangle indicates whether the items
have been sorted in ascending ( ) or descending ( ) order. If the items have been sorted
based on several columns, a number is shown next to the triangle. Number 1 indicates
the column that the items have been first sorted by, number 2 the second column the
items were sorted by and number 3 the last column that the sort is based on.
You can define the list to display either one item or a group of items by defining general
string criteria for the search bar, and column-specific string, list and selection criteria
for the advanced search bar. The list is refreshed when you click the refresh button. If
the displayed list is extended, the refresh button begins to flash after changes have been
made to search criteria.
You can modify column widths depending on how you want the data to be displayed on
screen. You can change the order of columns by dragging.
These functions are only available if they have not been disabled in list configurations.
Right-clicking the column heading displays the following pop-up menu:
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Menu_list_column.jpg

Figure 7-1 List menu
Table 7-1 List menu items
Item

Description

Primary Sort

The items are first sorted by the column you clicked to display the
pop-up menu. Select an ascending or descending order. A triangle
and the number 1 (
or
) is displayed in the column. The
number is only displayed if the items are sorted by more than one
column.

Secondary...Fifth Level
Sort

The items are sorted in the second (or fifth) place by the column
you clicked to display the pop-up menu. Select an ascending or
descending order. A triangle and the number 2 (-5) (
is displayed in the column.
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or

)

Column Widths by Contents

Resizes the list column widths to the default column width.

Print

Opens the Print dialog that allows you to print all list pages (the
list displays columns starting from the left according to the width
of the paper).

Search

Enables the search bar. Selecting the command again disables
the search bar.

Advanced Search

Enables the advanced search bar. Selecting the command again
disables the advanced search bar.

Appearance Locked

Locks the appearance of the list. Only the Primary Sort is active
and the order of the columns changes.

Sorting Locked

Locks the sorting configuration of the list, and you can no longer
change the column that the sort is based on by clicking a column.
However, you can still sort items using the options in the pop-up
menu. Selecting the command again releases the lock.

New

Creates a new item. This option is only displayed in lists that allow
items to be added.
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Item

Description

Properties

Displays the Properties dialog, where you can change the
appearance and functions of the list.

You can view and, with sufficient authorizations, change (in Edit mode) item data directly
in the list or in the general Properties dialog by clicking the item.
The data for one item, displayed in a list row, is presented in a row of its own in the
Properties dialog.

List_Properties_dialog_box.jpg

Figure 7-2 List properties

You can select how the information is presented in the window. The options are shown
in the following table.
Table 7-2 Properties dialog icons
Icon

Description
Grouping
Click the Grouping button to turn grouping on/off.
When grouping is on, the information is presented categorized under group titles.
When grouping is off, the information is presented in a list format without any
titles.
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Icon

Description
Alphabetical order
Click the Alphabetical order button to turn alphabetical order on/off.
When alphabetical order is on, the information is shown in an alphabetical order,
from a to z.
When alphabetical order is off, the information is shown in the same order as in
the chart columns.
Selected only
Click the Selected only button to show the selected / all information.
When the selected only is on, only items selected to be viewed in the chart
columns are shown in the Properties window.
When the selected only is off, all items are shown in the Properties window,
even those that are not shown in the chart columns.
Include read-only
Click the Include read-only button to include/exclude the information that has
a read only status.
When the read-only information is included, you can view also items that cannot
be edited.
When the read-only information is excluded, you can only view items that can
be edited.

When you click a row in the Properties dialog, the explanation of the data on the row
(and in the corresponding column) is displayed at the bottom of the window.
For more information about the Properties dialog, see 4.6, Properties dialog.
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7.1.

List screen
Sample list view

Example_list_small.jpg

Figure 7.1-1 Sample list view
Table 7.1-1 List view fields and activation buttons
Field / button

Description

Row Numbers

The row numbers are optionally shown in the beginning of the row.

Search bar

String criteria that are compared with text in all columns. The criteria
can contain several query strings. A query string can include wildcards.
For further information, see Selection of items.

Advanced Search bar The row under the Search bar is an advanced search bar where you
can define column-specific selection criteria. Depending on the column,
the criteria can consist of string, list, yes/no, or time span condition.
An advanced search bar list box for columns that can only include certain
values. Select the criteria from the list.
Advanced Search bar
Only the items that meet the selected criteria is accepted.
list box
Most lists with restrictions on the amount of data retrieved (but not, for
example, the event log, where the amount of data is unrestricted) allow
you to enter string masks like the one on the Search bar.
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Field / button

Description
A text selection box for text and figure columns. Enter a string mask
like the one used in the Search bar in the text box.

Advanced Search bar
String mask: Enter a string mask that is compared with the column
text box
texts. The properties of string masks are explained in the search bar
description Selection of items.
Yes/no criteria: Used for columns whose value is yes or no. Click to
change the criteria. Each click changes the criteria to the following one.
The criteria include the following:
•
•
•

Enable mask

Column headings

Order indicator

: All items accepted (value Yes or No).
: Only items whose value is Yes are accepted.
: Only the items whose value is No are accepted.

Checkbox for time columns. If the checkbox has been selected, the
bottom of the list displays a time bar where you can select criteria for
the time span. The time span is selected as described in 5.4, Time bar.
The left side of the interval row displays the column that the criteria are
linked to.
The descriptions of column headings are displayed at the bottom of the
Properties dialog. For more information, see 4.6, Properties dialog.
Indicates the column based on which the items are sorted. The list can
be sorted by a maximum of five columns. A number displayed next to
the triangle indicates the order in which the column is used in the sorting.
The direction of the triangle indicates which of the following ways the
items have been sorted by:
Normal order: Ascending order = depending on the type of data in
the column, an alphabetical, or numerical order from smallest to largest
(for example, A-Z, 0-9).
Reverse order: Descending order = depending on the type of data
in the column, an alphabetical, or numerical order from the largest to
smallest (for example, Z-A, 9-0).
For information about sorting items by clicking the column headings of
a single column, see Sorting list items using column headings. For
information about sorting the items by several columns and by using
the commands in the pop-up menu, see Sorting the list items using a
popup menu.
Refreshes the list data.

Refresh

In bigger lists, automatic refresh has been blocked. These list screens
display a Refresh button that begins to flash when search criteria have
been changed. In these cases, list refresh is activated with the Refresh
button.
Moves the list into editing mode where you can add and delete items
and edit their information, depending on the list.

Edit
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Field / button

Description
Click the right side of the column heading with the
pointer to change
the column width to accommodate the longest text in the column.

Changing the order of columns
You can change the order of columns by clicking a column heading and then moving
the column either to the right or the left in the table.
If the row number is shown, it is in the beginning of the row.

List_sorting_titles2.jpg

Figure 7.1-2 Sorting of titles

Sorting list items using column headings
Click the column heading to sort the items based on a single column.
•

Click the heading of the column by which you want to sort the items - for example,
Name.
The sort indicator ( ) ) is displayed in the heading, and the items are resorted. When
you select the column for the first time, the items are sorted in normal order ( ).

Example_list.jpg

Figure 7.1-3 Sample list
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•

Click the same column again if you want to sort the items in reverse order ( ).

Sorting the list items using a popup menu
•

The primary sort (default sort) is always selected in the list. If you want to sort the
items by more than one column, select the following columns in numerical order first the Secondary Sort, then the Tertiary Sort option, and so on.

To change the column used for a (primary, secondary) sort:
• Right-click the heading of the new column, and select the sort option (Primary Sort
/ Secondary Sort) and direction.
• You can also change the column used for primary sort by clicking the new column.
To change the sort direction of the column:
• Select the same sort option and a new direction.
• You can also change the direction of the sort column by clicking the column.
To delete a sort order:
• Click the column. If you click any column other than that used for primary sorting,
the column becomes the primary sort column, other columns are preserved and the
number of sort columns decreases by one (if you click the primary sort column, only
the sort direction changes).

Example_list_plain.jpg

Figure 7.1-4 Sample list plain

Selection of items
Use the search and the advanced search bars to reduce the number of items displayed
and to view only selected items. You can search for a single item or an item group
depending on the string criteria you enter, the criteria you select in a list or other type
of criteria. Only the items that meet all the criteria of the search and advanced search
bars are displayed.
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Different criteria on search and advanced search bars:
•
Search bar: Defines the string mask that is compared with
the texts in all columns. The string mask can consist of several query strings.
The query string has the following properties:
• The ? wildcard replaces one character.
• The * wildcard replaces zero or more characters. If you have enabled automatic
refresh, you can reduce the number of variables (rows) displayed by entering more
characters in the query string between the two asterisks.
• If you enter an asterisk (*) as the first and last character in the query string, the string
that meets the criteria can appear anywhere in the column. Otherwise, the string
must be at the beginning and/or end of the column.
• When limiting numeric data, characters can be used to limit numbers based on values.

•
•
•
•

•

These characters include:
• equals (=)
• bigger than (>)
• smaller than (>)
• bigger than or equal (>=)
• smaller than or equal (<=)
Vtrin does not add an asterisk at the end of the query string.
You can search for column texts that end in specific characters.
The query string is case-insensitive.
The string mask can include several query strings that have to or cannot be included
in the displayed items. Use commas (,) to separate query strings. You can only use
exclusive query strings in the advanced search bar. If you use them on the search
bar, the string must be found in all columns to limit off a row .
• If you do not want the query string to be included in the search results, use an
exclamation mark (!) or minus sign (-) in front of it and add it to the string mask.
Exclusive query strings can also include asterisks.
• The items selected are those that include one or all the "positive" search criteria
(the ones that do not begin with an exclamation mark or minus sign) and no
"negative" criteria (the ones that begin with an exclamation mark or minus
sign).
• For example, the string mask string1,string2,!string3,!string4 means that string1
and/or string2 must be included, while string3 and string4 cannot be included
in any of the displayed items.
• The following characters cannot be searched for - that is, you cannot use them
in the query string: "*", "?" and "," .The following characters can be used in a
query string but not as the first character: "!" and "-".
• To avoid automatic refresh from causing too large of a load on the system, each
keystroke is followed by a short delay before the system initiates a search. This
allows you to enter the entire string mask before the search begins.
Advanced Search Bar: Includes string, list, yes/no, or time span conditions related
to the column below. All the criteria in the selection boxes and the string criteria in
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the search bar are combined with an AND operator, that is, the displayed items must
meet all the criteria listed in 7.1, List screen
To use the search and advanced search bars:
1. Enter the string mask in the search bar.
2.
Enter the string mask in the string mask fields in the advanced search bar (
)
above the column names.
3. Select the required options for columns from the list criteria boxes on the advanced
4.
5.

6.

7.

8.

search bar (
) above the column names.
Select the required options for columns from the yes/no boxes on the advanced
search bar (
) above the column names.
Select the required time spans for time columns by first selecting Enable search
above the columns and then selecting the time spans from the time bars displayed
at the bottom of the list.
If the list to print is short, Vtrin continuously monitors items as you enter string
criteria and select options, and only displays the items corresponding to the criteria
and options. When the refresh button is flashing, click
Refresh to
activate the selections and view the results.
When you close the list window, you can save the content of the advanced search
bar and the appearance of the window (for example, column width). The content of
the search bar is not saved.
This enables you to create a variable list that displays all floating-point variables
for department X. When you open the variable list, you can, for example, select to
only view variables with the character ‘z’ in some column by entering string mask
*z* in the search bar. Closing the window does not change the original list.
You can save the content of the advanced search bar when
you close the list window. The contents of the search bar are
never saved.

7.2.

Variable list
The variable list displays the database variables, which you can sort based on various
data and search using different criteria. You can also create, rename, and delete variables,
if you have sufficient rights for that.

Description of variable list
Open the variable list from the tree. You can also create your own variable lists by editing
the basic variable list and placing the variables anywhere in the tree. The default variable
list, however, remains in the Variable lists folder inside the Maintenance folder. This
folder contains pre-configured lists for different types of variables.
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The information displayed in the list depends on the customer. To view the meaning of
columns, click the variable in any column of the list (the current value column does not
open). This displays the variable information (columns) one below the other in the
Properties dialog. Clicking a row in the Properties dialog displays the explanation of
the information (column) at the bottom of the dialog. For more information, see
4.6, Properties dialog.
Section 7.1, List screen explains how to sort the variables by different data fields and
search them by different criteria.

Variable list

Example_list_plain.jpg

Figure 7.2-1 Variable list
Table 7.2-1 Variable list
Field

Description
For descriptions of common list boxes (for example, Search) see
7.1, List screen.

Column headings

The descriptions of column headings are displayed at the bottom of the
Properties dialog. For more information, see 4.6, Properties dialog.

Current value

The variable’s current value and its status icon. These are not displayed
in the Properties dialog because they are a combination of different
database attributes. Status icons are described in 4.10, Icons.

Activation buttons

Description
For descriptions of common buttons, see 7.1, List screen.

7.3.

Event and alarm tables
The system can have two types of event and alarm tables:
• Events and alarms related to the system variable are collected in the alarm table. In
the alarm table, the events are in the order of arrival and consist of event activity
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•

7.4.

and alarm acknowledgement information. Alarm table printouts are described in
7.4, Alarm and event lists.
Event table displays the system events that do not have variables in the database.
In this case, the event row contains all the information available to the user. Event
table printouts are described in 7.4.1, Event log.

Alarm and event lists
Alarm and event lists provide different views of the same alarm table.
The alarm list is used to acknowledge new alarms and it shows all active and unacknowledged process alarms triggered by the system. You can sort the alarms based on various
data and search them using different kinds of criteria.
As an option, you can enable a talking alarm for newly specified alarm types. (Currently
available in Finnish only).
The event list displays the alarms and events triggered by the system. You can sort the
events based on various data and search them using different kinds of criteria.

Description of alarm and event lists
You can open an alarm or event list in the tree or by clicking an alarm list icon configured
on the status bar. You can also create your own lists by editing the basic list and place
them anywhere in the tree. The default lists, however, are located in the Events and
alarms folder.
The alarm list shows all active (not deactivated) and unacknowledged (including deactivated) alarms in the order of arrival. An alarm is removed from the alarm list when it
has been deactivated and acknowledged.
The event list shows all events, including alarms, in the order of arrival (default).
The information (columns) displayed in the list are defined specifically for each customer.
The available columns are shown in Table 7.4-1. To see the meaning of a column, click
the list row: this will display row information (columns) one under the other in the
Properties dialog. Clicking a row in the Properties dialog will display the explanation
of the information (column) at the bottom of the dialog. For more information, see
4.6, Properties dialog. You can group the lists into ordered lists based on alarm priority
or process area.
You can select the alarms/events shown in the list from the alarm table information based
on the following criteria:
• Event time (the time span for which alarms/events are shown)
• Priority (all; alarms; warnings; notifications; events [event list only])
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•
•

Process area (grouping variables by process area)
Variable-specific identifications

You can sort the alarms/events shown in the list based on the following criteria (see
Chapter 7, Lists for more information on how to sort the alarms by different data fields
and search them using different criteria):
• Event time (normal)
• Priority
• Variable-specific identifications
Acknowledge the alarms in the alarm list by first selecting the alarm rows you want to
acknowledge and then by sending an acknowledgement message.
As an option, you can enable a talking alarm for newly specified alarm types. (Currently
available in Finnish only). Talking alarm is implemented with the server's sound card.

Alarm list

Alarm_list.jpg

Figure 7.4-1 Alarm list

Event list

Event_list.jpg

Figure 7.4-2 Event list
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Table 7.4-1 Available alarm and event list columns
Alarm and event list
columns

Description
For descriptions of common list boxes (e.g. Search and Advanced
Search Bar, see 7.1, List screen.

Column headings

The descriptions of column headings are displayed at the bottom of the
Properties dialog. For more information, see 4.6, Properties dialog.

Columns available for
the lists
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Event priority

The priority of an alarm/event can be:
• A critical alarm
• A warning
• A notification
• An event (event list only).

Alarm status

The Alarm status icon indicates the current status of the row:
• Active unacknowledged alarm
• Active acknowledged alarm
• Passive unacknowledged alarm or an event list event
• Passive acknowledged alarm or an event list event.

Event time

Event time is the effective time of the alarm/event, which is the time
stamp of the variable’s current value when the status becomes effective.
In the case of a measurement, the time stamp is normally generated by
the measurement system, and in the case of a calculated variable by
the calculation program.

Return priority

Return priority indicates the priority of the alarm at the moment it was
removed.

Return time

Alarm/event return time is determined in the same manner as event
time.

Trigger and limit
value

Trigger and limit value indicate the cause of the alarm/event. This can,
for example, be going below or above a current value limit.

Value

Value indicates the variable’s current value at the time the alarm/event
was generated.

Duration

The period for which the status was valid. Updated when the status is
changed.
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Alarm and event list
columns

Description

Variable identification The variable is identified in the row with the following information:
data
• Variable
• Description
• Unit
• Area
• Process
• Alias
Alarm list button

Description

Area icons

Area icons can be configured in the status bar.
Each icon indicates the types of alarms occurring in each process area
in the following order of priority:
• Active unacknowledged (flashing)
• Active
• Deactivated unacknowledged (flashing)

Acknowledging alarms
To acknowledge alarms:
1. Select the rows you want to acknowledge from the alarm list.
• Select a single row by clicking it. The color of the row changes when it is
selected.
• Select several rows by clicking a row on one side of the desired area and then
by clicking on the other side of the desired area with the Shift key held down.
The selected rows change color.
2. Acknowledge the selected rows by right-clicking and choosing Send To and then
Acknowledge from the popup menu. The mouse must be clicked in the selected
area, otherwise you will acknowledge the row under the mouse instead of the
selected area.
3. Click anywhere outside the selected area to deselect it.

Viewing the alarm list
7, Lists explains how to sort the alarms by different data fields and search them by different criteria. The columns of the alarm list are shown in the table on the previous page.

7.4.1.

Event log
The event log shows system events. You can sort the events based on various data and
search them using different kinds of criteria.
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Description of event log
Open the event log in the tree. You can create your own event logs by editing the basic
event log and place them anywhere in the tree. The default event log, however, will
remain in the Maintenance folder.
The data displayed in the event log depends on the customer. To see the meaning of
columns, click the event in the first column of the list. This will display the event
information (columns) one under the other in the Properties dialog. Clicking a row in
the Properties dialog will display the explanation of the information (column) at the
bottom of the dialog. For more information, see 4.6, Properties dialog.
7, Lists explains how to sort events by different data fields and search them using different
criteria.

Event_log.jpg

Figure 7.4.1-1 Event log
Column heading

Description
For descriptions of common list boxes (e.g. Search and Auto) see
7.1, List screen.

Column headings
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8.

Status window
The variable's Status window displays the current value of the selected database variable.
You can also remove the variable from current value processing in the Status window
and replace the variable with a different value.

Description of status window
The window displays the variable's name, description, current value and status, unit,
time stamp, and status both as an icon and as text. The title bar displays an icon corresponding to the variable's type when the status is OK, and a status icon in other cases.
You can remove the variable from current value processing and give it a new current
value. To define a floating-point variable, move the slider to the required value or enter
a figure in the box. For binary variables, select a value from the list.
Click

to open the variable's Properties dialog.

Display

Status_window_analog.jpg

Figure 8-1 Status window analog

Status_window_binary.jpg

Figure 8-2 Status window binary

If there are only two values, they are placed side by side, instead of a list.
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t_sum.jpg

Figure 8-3 T_SUM status
Table 8-1 T_SUM status fields
Field

Description

Type icon

A variable-type icon on the left of the title bar, if the variable’s status is
OK.

Status icon

Icon representing the variable’s status. Displayed on the left of the
description. If the status is not OK, the status icon is displayed on the
left of the title bar, which otherwise displays the variable’s type icon.
Status icons are described in 4.10, Icons. If binary variables, the window
displays the symbol of the binary state, which is defined so that its color
indicates the (quality) status and its form the value.

Name

Name of variable. Displayed in the title bar.

Description

Description of variable. Displayed below the title bar.

Current value processing

If selected, the value from the process is used for the variable. If not
selected, the value is used for the variable.

Time

Time stamp for the current value.

Value

Current value. If binary variables, the binary state as text.

Unit

The engineering unit of the value in the database.
Indicator of the direction of change. The arrow indicates the direction
of the latest change in the current value of the floating-point variable:
: Increasing value

: Decreasing value

: Unchanged value

The new value of the floating-point variable indicated by the slider. You
can provide a new value either by moving the slider or by entering a
figure in the box. The left end of the line represents the minimum value
in the range, and the right end the maximum value. The range is also
displayed as a tool tip text when you position the pointer in the slider
area.
New value for floating-point variable as a figure. You can provide a new
value either by moving the slider or by entering a figure in the box.
New value for binary variables. Select a new value from the list.
Acknowledged/unacknowledged = a variable has an unacknowledged
alarm)
Status
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Field

Description

Status icons

The variable’s valid states are displayed at the bottom of the window
using colored icons. Status icons are described in 4.10, Icons.

Table 8-2 T_SUM activation buttons
Button

Description
Not yet supported.
Displays the Properties dialog of the variable.
Makes the new value displayed in the box (floating-point variables) or
in the list (binary variables) the variable’s current value.

Opening the Status Window

Menu_open_status_window_from_list.jpg

Figure 8-4 Opening the status window

•
•

Right-click any other column than the current value or the alarm list variable column
on the variable's row in the variable list or chart window legend.
Select Send To and then Status Window.
OR

Menu_open_status_window_from_current_value.jpg

Figure 8-5 Opening the status window

•

Right-click a current value (value, symbol, or column) in the process diagram and
then select status window.
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Table 8-1 Status window items
Item

Description

Send To

Opens a variable specific pop-up menu from which you
can select a display type.

Status Window

The status window of a selected variable.

Diary

A diary, if such is configured into the system.

Current Trend

The default current trend of a selected variable.

Hourly Trend

Hourly average values of a selected variable (if collected).

Copy

Copies the basic information of a selected variable.

Copy Selected Data

Copies the selected piece of information of a selected
variable.

Delete

Deletes the selected variable from the database.

Properties

Opens the Properties window of a selected variable

Setting the value of a process variable or a calculated
variable
1.
2.
3.
4.

120

Remove the variable from current value processing in the Current value processing
checkbox.
Select a new value for the floating-point variables by using the slider or by entering
a new value in the box. If binary variables, select a new value from the list.
Set the value as the current value by clicking
Set.
The variable's status changes to replaced. The new value remains the variable's value
until you manually set a new value or allow current value processing in the Status
window. The variable begins to receive values from the process or the spreadsheet
application.
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9.

Default trends
The variable's default trend enables you to, for example, use the variable list to open a
chart window displaying the variable's plot.

Description of default trends
The default trend is a chart window defined for the variable, which displays the variable's
plot. A variable can have several default trends that retrieve the information for plots
from different time levels - for example, from the current value or one-minute average
value history.

Default trend

Default_trend_display.jpg

Figure 9-1 Default trend display
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9.1.

Opening a default trend

Menu_open_status_window_from_list.jpg

Figure 9.1-1 Opening a default trend

To open a default trend:
1. Right-click any column other than the current value or the alarm list variable column
on the variable's row in the variable list or the legend in the chart window.
2. Select Send to and the required default trend.
OR

•

Right-click a current value (value, symbol, or column) in the process diagram and
then select the desired default trend.
Do not replace the default trend so that the original default
trend is not lost.
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10.

Templates
A template contains certain properties and the layout of a chart window. Using the
appropriate template to create a chart window enables you to quickly create a functional
window complying with the agreed standard by simply adding the required graphs.

Display_template.jpg

Figure 10-1 Display template

Using templates
To create a new template-based chart window:
1. Using an appropriate template, create a chart window in the tree’s folder and open
it.
2. Open the variable list or another chart window that displays the variable rows in its
legend (the two methods lead to slightly different results).
3. Drag the required variables from the variable list or from the legend of the chart
window to the legend or chart of the new window.
For more detailed instructions, see 10.1, Creating a chart window using a template.
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10.1.

Creating a chart window using a template
Right-click the tree's folder in which you want to create a chart window. Select New
Tree Item and the required template.

Menu_open_new_tree_item.jpg

Figure 10.1-1 Creating a chart window using a template
Table 10.1-1 Templates
Template

Description

Trend and diagrams

Select the folder into which you want to create a chart.

New Tree Item

Opens the template pop-up menu.

Trend

Select a template you want to use.

The folder displays a new chart window item, with the name New and the name of
the selected template. Enter an appropriate name for the window.

Open the new chart window. The window displays the name you entered.
Add graphs to the chart by dragging a variable from the variable list or a variable
row from a legend of another chart window. In terms of the determination of plot
configurations, these two methods differ in the following way:
When you drag variables from the variable list, the graph definitions comply with
the template defaults and the graph color with the order of addition. When you drag
variable rows from another chart window, the graph definitions comply with the
original graph.
When dragging a variable or variable item from another
database, the default definitions are not copied along with
the variable. In this case the history table for the new item
has to be updated from the Properties dialog.

To add graphs from a variable list:
1. Open the variable list. To simultaneously view both the list and the chart window,
move the variable list to a new horizontal tab by opening the Window menu in the
menu bar and selecting Move to a New Horizontal Leaf.
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2.

3.
4.

In the variable list, locate the variables that you want to add to the chart. The easiest
way to find variables is by using search criteria in the search bar and in the selection
boxes. For more information, see 7, Lists, Selection of items.
Select the variable row (by clicking) and drag it to the chart window's legend or the
chart (plot area).
You can also select several variables one by one by pressing the CTRL button and
holding it while selecting variables.

Add_new_variables_from_list.jpg

Figure 10.1-2 Adding graphs from a variable list

5.

Add the rest of the graphs in the same way. The graph definitions comply with the
default settings of the template.

New_variables_from_list.jpg

Figure 10.1-3 Adding new variables from list

Adding graphs from the legend of the chart window:
1. Open the chart window where the properties of the graphs are displayed in the legend
rows. To simultaneously view both the list and the new chart window, move the
chart window to a new horizontal tab by opening the Window menu in the menu
bar and selecting Move to a New Horizontal Leaf.
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2.

Drag the variable row from the chart window's legend to the legend or the graph
area of the new chart window.

New_variables_from_chart_window.jpg

Figure 10.1-4 Adding graphs from the legend of the chart window

3.

126

Add the rest of the graphs in the same way. You can also add graphs from several
chart windows. The definitions of the added graphs (for example, the color and the
table [if the table has been identified, the default table is changed] where the history
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values are retrieved from) is like those of the chart they originated from. The addition
of graphs does not affect the chart window interval.

New_variables_from_different_time_span_chart_window.jpg

Figure 10.1-5 Adding new variables

4.

If you want to change the properties of the graphs added to the chart of the new
window, such as the colors and graph styles, do this in the chart’s Properties dialog.
Save the chart window when prompted to save changes.
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11.

Data historian backup and restore functions

11.1.

Taking a backup of the Data historian
Ensure that the actions below are done from administrator
command prompt.

To backup Data historian :
1. Log into the COM600 computer operating system.
2. Open the command prompt window (Start > Run > cmd).
3. Set the path to the backup media where the backup is to be stored by setting the
ABB_BACKUP_ROOT environment variable.
For example, backup path can be set to D:\RTDB_BACKUP
SET APP_BACKUP_ROOT=D:\RTDB_BACKUP.
4. Start the creation of backup with command APP_PrepareDatabaseForOnlineBackup.
5. Wait until the backup script is finished.
6. Close the prompt window.

11.2.

Taking a Data historian online backup
You can take a backup of the Data Historian application either manually using a bat file
or automatically by setting the Windows task scheduler to take an automatc backup at
certain intervals.
You can take a manual backup by using the COM600RTDBBackup.bat script. The script
is located at C:\Program Files\COM610 GW SW\Common\bin folder in the COM600
computer.
Note that you need admin rights to the computer run the script and perform the backup
successfully.
The script takes an input parameter, which indicates the folder of which the backup is
taken. When the input is valid, the script launches the APP_PrepareDatabaseForOnlineBackup.bat script, which makes an online backup of the Data Historian application.
The script also sets up the APP_BACKUP_ROOT system environment variable, that is used
for the Data Historian backup.
Ensure that the actions below are done from administrator
command prompt.
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To manually backup Data Historian application:
1. Log into the COM600 computer operating system.
2. Open the Command Prompt by choosing Start>Run>cmd. Make sure that you have
logged in as an administrator.
3. Change the runtime directory to C:\Program Files\COM610 GW SW\Common\bin.
For example, cd “C:\Program Files\COM610 GW SW\Common\bin” .
4. Launch the COM600RTDBBackup.bat script and verify the intended backup location. For example, COM600RTDBBackup.bat “C:\RTDB Backup”
5. Wait until the backup script is finished.
6. Close the command prompt window.
To make the backup automatic, you can set the Windows task scheduler to automatically
perform the backup function at certain intervals.
The task is named \COM600\COM600RTDBBackup in the Windows task scheduler.
It is disabled by default.
When enabled, the task launches the COM600RTDBBackup.bat script with the intended
backup location as the input parameter.
To automatically backup Data Historian application:
1. Log into the COM600 computer operating system.
2. Launch Windows Task Scheduler from Control Panel>Administrative Tools.
3. Locate the COM600RTDBBackup task as shown in the picture below

Data_Hist_Task_Scheduler.png

Figure 11.2-1
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4.
5.
6.

Right click the COM600RTDBBackup task and select Properties to enable the
task and set the time interval for task execution.
In the following COM600RTDBBackup Properties dialog, select the Triggers
tab.
Double click on the Daily Trigger entry to setup time interval for task execution
and click Ok. Make sure to check the Enabled check box to enable the task.

Data_Hist_Edit_Trigger.png

Figure 11.2-2

7.
8.
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Data_Hist_Edit_Action.png

Figure 11.2-3

9.

Edit the textbox for Add arguments (optional) to change the intended backup
location. Then click Ok.
10. Click Ok in the COM600RTDBBackup Properties to confirm the changes made
to the properties of the task.
11. Run the COM600RTDBBackup task. Check the backup result in the Windows event
log using Windows Event Viewer tool. You can open it by choosing Control Panel
> Administrative Tools.

11.3.

Restoring Data historian backup
To restore Data historian backup:
1. Log into the COM600 computer operating system.
2. Open the command prompt window (Start > Run > cmd).
3. Stop the Data historian services with command APP_STOP_RTDB
4. In Windows Explorer, delete or rename the existing C:\RTDB Backup\Onlinecopy
directory.
5. Copy the backed up Onlinecopy subdirectory from the backup media to directory
C:\RTDB Backup.
6. Start the restore function with command APP_RestoreRtdbFromOnlineBackup.
7. Wait until the restore function is finished and restart the COM600 computer.
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